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[image: ] OmegaT (OT) is a free open-source CAT tool which is being used by DGT for prototyping since 2012 and is used by some translators as an alternative to DGT main CAT tool. 
This adapted version of OmegaT is internally referred to as DGT-OmegaT (DGT-OT) to differentiate it from the standard version. 
For simplicity’s sake, in our in-house Guides it is always referred as DGT-OT although most of the features are from the standard OmegaT. 
This is the Quick Guide for the 2017 version which has some important improvements (for DGT translators) over the standard OmegaT version 3.6.0_7 and which is further integrated in DGT’s translation environment with the in-house applications DGT-OT Wizard, TeamBase and TagWipe.
In 2017, DGT-OmegaT, its Wizard, TeamBase and TagWipe were published as free open-source software (FOSS) and therefore they can be used outside DGT, thereby contributing to the open-source community. However, some features may not be available and others may need the definition of some settings. 
As both the binaries and the source code are published, there may be adapted/new features which might also satisfy the needs of translators outside DGT and which the standard OmegaT community might consider of interest to integrate in its application.
If you want to try/use the DGT-OmegaT free open-source version, see the information on its website: 
· http://185.13.37.79/: to download the binary version (easy to install) and/or the source code and respective documentation
· http://185.13.37.79:8003/ for developers and bug reporting

[bookmark: _Toc499734018]A - WHAT IS DGT-OMEGAT?
[image: ]  OmegaT (OT) is a free open-source Computer-Assisted Translation (CAT) tool, developed by private initiative, originally by Keith Godfrey in 2000, which is currently developed by a team led by Didier Briel (see OmegaT Help  About for a list of contributors). OmegaT is now the leader free open-source CAT tool.
OmegaT is being used by DGT for prototyping since 2012 and can be used by translators as an alternative to DGT main CAT tool. This adapted version of OmegaT has some important improvements (for DGT translators) and is further integrated in DGT’s translation environment with the following applications developed in-house: 
· DGT-OT Wizard for the management of projects within DGT workflow
· TagWipe for the cleaning of useless tags in DOCX files (the huge majority of our source documents)
· TeamBase for sharing memories in real-time among translators working with DGT-OT and/or Studio
This is the updated in-house Quick Guide for the DGT-OmegaT 2017 version. 
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[bookmark: _Toc499734019]B - HOW TO INSTALL DGT-OMEGAT?
If you in DGT and want to try/use DGT-OT, its Wizard and TeamBase, just send an e-mail to Alfons de Vuyst (Head of the Operational Support Sector (R3)), with copy to Elio Fedele, and it will be quickly installed in your computer.
If you are a teleworker, DGT-OT will not slow you down as it is not a resource‑hungry application and backups are done in a fast background process without your noticing it. 
If you are not a teleworker, but you sporadically need to translate at home, you can use DGT-OT just by copying it to your private computer as there are no license issues. Of course you will not have access to DGT databases and Teambase and some of the Wizard features will not be available. Ask for help to do it.

[bookmark: _Toc499734020]C - HOW TO USE DGT-OMEGAT?
For the DGT version of OmegaT, you have the following documentation:
i. Quick reference (Section 0 of this Guide): the really basic information to start translating with DGT-OT right away
ii. This Quick Guide (see detailed index with clickable links at the end)
iii. The Thematic Guide (click on Guide in the DGT-OT Wizard)
	The Thematic Guide should be read as a complement to this Quick Guide. In it, the most important features are explained in detail for absolute beginners and, if you really want to use DGT-OT’s full potential, it is worthwhile to know more about those which are more important to you. The Thematic Guide has not been updated (yet).
iv. If you are already a DGT-OT user, in the DGT-OT Wizard you can click on News to see the differences between the 2016 and the 2017 versions.
[bookmark: Sect_00]You can also see the Guides of the standard OmegaT available by clicking on Other Guides, but there are substantial differences in the version we are using in DGT.

[bookmark: _Toc499734021]D - ACKNOWLEDGMENTS
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[bookmark: _Toc426467285][bookmark: _Toc426467279]
[bookmark: _Toc499734022]0. QUICK REFERENCE
These are just the basic steps to create, translate, share memories in real time (TeamBase), send for revision and finalize a project with DGT‑OT [image: ] and its Wizard [image: ]. For a more detailed explanation of each feature see the following sections. 
[bookmark: _Toc468881058][bookmark: _Toc499734023]A — Create a single or multi-document project	
See also Point G (Interoperability with Studio) if you want to create a project  for translation or revision  using sdlxliff files.
a) In Tradesk, make a Local copy (you can use the “Local copies” tab in Tradesk) of the original documents (2010 Office format or other formats like xml, html...) to your computer. NB: doc and rtf formats have to be saved as docx.
	They will be automatically copied to the Dossiers folder (C:\Users\{your login}\AppData\Local\Local Documents-no backup\DGT\Dossiers). 
b) With DGT-OT closed, click on the DGT-OT Wizard icon in your desktop. If it is not your first project, select Clear before starting the process.  
c) Select the source and target languages from the dropdown menu (if not already defined).  
Don’t forget to check if the language pair is correct. The DGT-OT Wizard cannot guess what it will be!
d) Click on Add — which by default will open a Windows Explorer window in the Dossiers folder — to select the folder where the original document(s) previously copied to your computer are. 
	You can select one/several/all in a same folder as is usually done in Windows Explorer (with Ctrl+Shift if several) and Enter or select from different folders. 
e) By default, the DGT-OT Wizard will give to the new project the name of the first document you added to the list, but you can change it in the Project field giving it a name that is meaningful to you.  
f) Click on Create and the DGT-OT Wizard will create the DGT-OT project. 
	By default, it will copy to your project the original documents (applying TagWipe to docx files) and all the retrievals, reference translation memories and Machine Translation files available in Tradesk. It will also copy an IATE extraction (source/target terms) except if you are using sdlxliff source files.   
	By clicking on Browse and on the name of the project, you can manage your project by adding/managing local memories or machine translation files in the \tm or \mt subfolders.   
g) Click on Open (which is displayed in green when the project has been created) and it will open that project in DGT-OT.

[bookmark: _Toc468881059][bookmark: _Toc499734024]B — Update a project with new original documents or memories available in Tradesk
In the DGT-OT Wizard, with the project you created as the active project (but with DGT-OT closed), do as explained above, under A, but click on Update instead of Create. 
By clicking on Browse you can delete previous versions of the documents in the project \source subfolder. 

[bookmark: _Toc468881060][bookmark: _Toc499734025]C — Translate sharing memories in real time with TeamBase
a) In the DGT-OT Wizard, with the project you created as the active project (open or not in DGT-OT), click on TeamBase.
b) Accept the default — which is to create a new TeamBase memory with the name of your project (or change its name as you wish) — or select a memory from the list displayed in the left column.
c) Select the mode in which you want to work: Read (only receive segments from colleagues connected to that TeamBase memory in Read/Write mode) or Read/Write (receive and send segments).
d) Click on Connect To Shared. 
The TeamBase window will close automatically and you can start/continue working on your project. You will always be in sharing mode whenever you close and reopen the project (unless you disconnect from it in the TeamBase window).
[bookmark: _Toc468881061]



[bookmark: _Toc499734026]D — Translate a project — main functions
a) DGT-OT starts by displaying the list of the documents in your project. Click on Close to accept the opening of the first segment of the (first) document or, in multi-document projects, select a different document from the list before clicking on Close. To display the list again to choose a different document, press Ctrl+L.
b) DGT-OT displays the first segment to be translated in the Editor and, by default, if there is a Euramis match above 70%, it will be automatically inserted in the segment open for translation.  
c) If there is no fuzzy match within the defined threshold, DGT-OT will insert the MT output (default). If you want to use Machine Translation (MT) output (which is displayed in the MT pane) even when a Euramis match has been automatically inserted in the target segment, just press Ctrl+M to replace it with the MT output.
d) Translate/correct each segment and press Enter to validate it — thereby sending it to the project memory where your work is stored — and to open the next segment for translation. Segments have 3 statuses: untranslated, translated and revised.  
e) If you want to go to another segment (far) above or below, just scroll/go to that segment and double-click on it to open it for translation. DGT-OT will save the segment you were in to the project memory and open the new selected segment. 
f) To insert in the target segment open in the Editor a Euramis match other than the first (higher) match displayed in bold in the Fuzzy Matches pane, position the cursor on the Fuzzy Match segment you want to use, double click on it (it will be displayed in bold as the selected segment) and use the shortcuts Ctrl+R or Ctrl+I to insert it — in the segment open in the Editor — either replacing the text there, if any, or inserting it at the position of the cursor, respectively.  
g) To access DocFinder/Quest/Euramis/IATE, highlight the term/string/OJ reference you want to search and click on the icons or use the shortcuts (Ctrl+Shift+F, Ctrl+Shift+Q, Ctrl+Shift+E, Ctrl+Shift+L, respectively). 
h) To View Other Target Languages — i.e. ongoing translations by colleagues from other Language Departments — just click on the respective blue icon. You can have another language displayed in the Editor, as a second (or third…) source language(s) (for segments without tags), by selecting the option Import tmx2source. There are also other options.  
i) To search terms/strings (Concordance), in the project and/or the reference translation memories and/or glossaries and or/notes highlight them in the Editor pane, press Ctrl+F and Enter if you want to accept the settings or, before pressing Enter, change the settings (DGT-OT displays the settings of your last search in that session). There are many options worth exploring!
j) If you want to filter terms/strings for editing — only in your project memory of course — just search them (as in point i) above) and click on Filter at the bottom of the Search window. Segments which fulfil the settings are displayed in the Editor for editing. To return to the full document, click on Remove Filter.
k) In DGT-OT, tags are displayed in grey and are just sequentially numbered within each paragraph (Example: <t0/> <t1/>).  
	To insert each tag, position the cursor where you want the tag to be inserted and press Ctrl+T. It will insert the first or next missing tag in that position. You can also right-click the mouse and choose the tag you want from the dropdown menu.  
	To check that there are no missed, repeated or “misplaced” tags in a document or in all the documents of your project, press Ctrl+Shift+V or Ctrl+Shift+J. By clicking on the number of the segment on the left, DGT-OT opens the segment in the Editor.  
l) The terms/strings with a blue linear and bold underline (by default) in the open segment in the Editor mean that there are (one or more) entries in one of the glossaries in the \glossary folder of your project (which are displayed in the Glossary pane). 
	By right‑clicking the mouse, the translation(s) of that term/string will be displayed in a dropdown menu. In the standard project creation with the DGT-OT Wizard, the glossary will be the IATE extraction.  
	To create entries in your project’s writable glossary, press Ctrl+Shift+G and fill in, at least, 2 (source and target) of the 3 fields.
m) You can also use the Auto-text feature, by pressing Ctrl+space and cycle through the options. But, for the Auto-text, first you have to enter the text you want in Options — Auto-completion — Auto-text.
n) There is also a new feature in the Auto-completion menu – History Completer  – which, depending on your preferences, presents suggestions (automatically or not) completing words  from words - not only in the project glossaries - but also from the project memory and external memories (History Completion) or suggesting next words (History Prediction) from segments in your project memories.
o) To view the original document, select - in the Project menu – View source file or press Ctrl+H and to view the translated document open in the Editor, select View target file or press Ctrl+G.
NB: You have to close the translated document before saving or creating it again otherwise a message will be displayed asking you to close it!

[bookmark: _Toc499734027]E — Send ongoing or finalized translated document(s) to Tradesk (in batch)
a) In DGT-OT, create the translated document(s) in their native application(s) by pressing Ctrl+D to generate all the target documents or Ctrl+Shift+D to generate only the document you are working on (in multi-document projects). 
You can also use the View target file feature if you want to check it in the native application and also if you want to save it to a project subfolder that is not the \target default subfolder.
b) In the DGT-OT Wizard, in Euramis/Tradesk, click on Send (don’t forget to check that the target document(s) are not open in their native application) accept the document(s) displayed by default and click on To TRAdesk.

[bookmark: _Toc499734028]F — Revision workflow always with DGT-OmegaT
The revision workflow is available in the right-side section of the Wizard. Don’t forget to close DGT-OT before using this feature!
a) Translator — Send: by clicking on the "Send" button and accepting the defaults in the Revision window, the project will be sent to a default server location where the reviser can get it.
b) Reviser — Get: by clicking on the "Get" button, the reviser can select — from the list displayed — the project (s)he wants to copy to his/her computer and open it as usual in DGT-OT.
c) Reviser — Send: by clicking on the "Send" button, the reviser can send the active revised project to the default server location where the translator can get it.
d) Translator — Get: by clicking on the "Get" button, the translator can select — from the list displayed — the revised project (s)he wants to copy to his/her computer and open it in DGT-OT for validation/finalization.
When the reviser opens the project for revision, to have segments marked as “revised”, (s)he must change the mode from Translation Mode to Revision Mode by clicking on the blue Rev icon (or selecting it in the Options menu). To open the next unrevised segment, just click on Ctrl+U. Don’t forget to select the Revision Mode every time you open a project for revision!
When the translator opens the revised project, to open and validate the segments changed by the reviser, just press Ctrl+Shift+Y.

[bookmark: _Toc499734029]G — Send individual memories of finalized documents to Euramis
If you finished your translation (revision included, if any) using DGT-OT and you want to send it to Euramis: 
a) In DGT-OT, export the individual memory of the document(s) in your project in the format accepted by Euramis by pressing Ctrl+Shit+F8.
b) In the DGT-OT Wizard, click on Euramis-Tradesk — Send — To Euramis, to send the individual memories so generated to Euramis. There is no need to select anything. The Wizard will just send all the memories you have generated. You can do it at the same time as you send the translated documents to Tradesk or later after closing/finalizing your translation task(s).

[bookmark: _Toc499734030]H — Interoperability with Studio – being tested
a) Revision of (free-lance) translations done in Studio
If you have one or several related (freelance) translations (in sdlxliff format) and you want to revise it/them in DGT-OT:
1. If it is a free-lance translation, first do a local copy in Tradesk of the relevant translated sdlxliff file(s) to your computer
2. In both cases, click on the sdlxliff box in the Wizard
3. Select the file(s) you want to use for revision.
	If it is:
i. A local copy of one or more free-lance sdlxliff translated files, select it/them from the C:\Users\{your login}\AppData\Local\Local Documents - no backup\DGT\Dossiers 
ii. One or more sdlxliff translated files that you got via the CAT Client with Get Review, select it/them from the C:\Users\{your login}\AppData\Local\Local Documents - no backup\DGT\Review Projects relevant folder(s).
4. Then follow the usual workflow in DGT-OT, including finalizing the project with the DGT-OT Wizard. 

b) Translation of sdlxliff original files to be revised in Studio
We are testing an in-house filter for sdlxliff files so, if you want to try it and if you have problems, shout for help! 
You can also open the DGT-OT project in Studio selecting – in the Project menu – Open in Trados Studio if you wish to continue working in Studio. But don’t forget that changes made in Studio will not be sent to the DGT-OT project!
In both cases, when finalizing a project in the DGT-OT Wizard, when you send the document(s) to Tradesk, you must clear the documents displayed and select the subfolder target-native and the relevant file(s) as the target file in the \target subfolder (the default) is the sdlxliff target file (not the native format target document).
For more information on how to manage project with sdlxliff files, see section 4.3.


[bookmark: _Toc426467289][bookmark: _Toc444875171][bookmark: _Toc499734031]1. DOCUMENTS AND PROJECT APPROACH
Now, virtually all CAT tools follow a multi-document project approach. We work within projects, which may have one or any number of documents in various formats — with hundreds/thousands of pages on the whole — that are treated in a single project in a speedy way, even when there are successive new versions — or new documents — during the translation of the project. 
In the DGT-OT project, you have all the memories (retrievals, reference translation memories and MT output) and an IATE extraction (automatically imported to each project) and you can also add glossaries, dictionaries and monolingual reference documents. Furthermore you can also gather in your project folder other material — technical or administrative — that you may need to manage/translate your project. 

[bookmark: _Toc426467291][bookmark: _Toc444875173][bookmark: _Toc499734032]1.1. Documents in a project	
The original documents can be:
a)		One, some or all documents of large packages with different dossier and part numbers.
b)		Documents of dossiers with numerous parts (like a model contract with several parts).
c) 		SRC files (usually Excel or PowerPoint files with tables, graphs).
d)		New versions of documents (quite frequent).
e)		Several small documents which you may want to gather in a project (like several replies to parliamentary questions, cartouches) even if unrelated, just to save time.
f)		Any combination of these. 
If your documents have a subfolder structure, DGT-OT will keep it. You can also easily change the order in which the documents are displayed in your project.

[bookmark: _Toc426467292][bookmark: _Toc444875174][bookmark: _Toc499734033]1.2. Interoperability between DGT-OT and Studio 
The standard OmegaT supports the xliff/sdlxliff format, but the filters available (both OmegaT and Okapi) have some shortcomings. So, for DGT-OmegaT a new in-house filter has been developed which is now being tested.
It is made available  although more testing is needed  as this is a very useful development for our daily work – both for revising free-lance translations and for exchanging projects for revision or revised between DGT-OT and Studio users.	
It is not perfect, but you can already — with some manipulations — translate a project in DGT-OT and have it revised and finalized in Studio or revise in DGT-OT a document translated in Studio and revise and/or update it with a new version in DGT‑OT. See Section 4.3.

[bookmark: _Toc499734034]1.3. Document formats 
In this new version of DGT-OT, the source documents can be documents in the native formats (docx, xlsx, pptx, html, etc.) or documents in sdlxliff format. They will all be displayed the same way as “raw” text in the Editor pane. Of the formats important to us, only the RTF format is not accepted by DGT-OT. 

[bookmark: _Toc426467293][bookmark: _Toc444875175][bookmark: _Toc499734035]1.4. Commission special formats: Budget and Refont
With Budget documents, you can still use DGT-OT. The only specificity is that you will have to convert the RTF files into DOCX files before creating the project and after finishing the translation reconvert them back into RTF format.
With Recast documents, you can use DGT-OT but, as this format is Commission-specific and not at all user-friendly in any CAT tool, maybe you will prefer to use the old TWB. 

[bookmark: _Toc426467295][bookmark: _Toc444875176][bookmark: _Toc499734036]1.5. Confidential documents (SECEM)
SECEM documents are subject to certain restrictions, namely that they cannot be sent over the network nor kept on a server or other shared place, except in the secured Tradesk environment. Now you can create this kind of projects via the DGT-OT Wizard by ticking the SECEM box and copying to the project the originals/tmx files you manually get from Tradesk. 

[bookmark: _Toc426467294][bookmark: _Toc444875177][bookmark: _Toc499734037]1.6. Multilingual source documents 
You can also translate multilingual documents in a single project without the need to divide the documents by source languages.


[bookmark: _Toc499734038]2. DGT-OT 2016, PROJECT WIZARD & TEAMBASE in a nutshell 
[bookmark: _Toc426467280][bookmark: _Toc499734039]2.1. DGT-OT
The standard OmegaT has been adapted and integrated in DGT workflow. This is what it looks like with its several panes: Editor, Fuzzy Matches, Machine Translation, Glossary, Notes, Multiple Translations and also the Translation Tips (Transtips) feature. The Dictionary and Comments panes are minimized in this Screenshot. 
For information on translating/revising a (single or multi-document) project, see Section 3 of this Quick Guide and, for in‑depth information, see the relevant sections of the Thematic Guide.
[image: ]
[bookmark: _Toc426467281]
[bookmark: _Toc499734040]2.2. DGT-OT Project Wizard
· DGT has also developed in-house a DGT-OmegaT Project Wizard (DGT-OT Wizard) to integrate DGT-OT in its workflow. 
In this Quick Guide you will find the general information you need to manage your projects easily. For in‑depth information, see the relevant sections of the Thematic Guide.  In DGT, the access to DGT‑OT is always via its Wizard.
[image: ]

The DGT-OT Wizard makes the link between Tradesk  DGT’s document management system  and DGT-OT and helps you to quickly create projects with all the reference/retrieval/machine translation memories and also an IATE extraction. 
You can also easily update projects with new original documents/new versions of documents already in the project and/or new memories, delete documents/memories from the project, add glossaries, organise translation memories, share memories via TeamBase, send translated documents to Tradesk, send finalized document memories to Euramis and archive finalized projects.
The revision workflow is a recent feature and you can send projects for revision and get the revised projects in a quick and easy way.
The DGT-OT Wizard also triggers automatic backups (every 30 minutes) of your active project to a server (your space in the H: drive) in a background operation you don’t see. 
To have the automatic backups done, the Wizard must always be open with the project you are working on selected as the active project!
A copy of your project memory (draft) is also sent every 30 minutes to Tradesk \pret folder(s) of the relevant dossier(s) (several in case of multi-document projects). So if, for any reason, another colleague has to continue translating your project  or you have to continue translating a project started by a colleague  and (s)he/you are not available to transfer it, that project can be easily (re)created, as usual, by you/your colleague with the work already done just by moving the draft memory automatically copied to the \tm\auto subfolder of the recreated project.
Furthermore, all the memories you send to Euramis via the DGT-OT Wizard are also copied (tmx file with tags) to the \Final folder of the relevant dossier(s) in Tradesk for later reuse either by a translator working in DGT-OT or by a translator using Studio (who can do a pre-translate with that/those tmx files).
You can also create projects with original documents whose numbers don’t follow DGT standard nomenclature. However, in that case, the DGT-OT Wizard will create the project but, obviously, there will be no retrievals, aligned reference documents nor MT output automatically copied to your project as there will not be any pre-processing.
The DGT-OT Wizard is easy to use as  for many of the project management operations  it just opens a Windows Explorer window and there you can copy, paste, delete, drag/drop and rename files in the usual manner at any time as, when DGT-OT opens a project, it has no “memory” of how it was before. It just opens the project, “reading” all the original files and translation memories.
For information on managing DGT-OT projects, see Section 4 of this Quick Guide and, for more in-depth information, see the relevant sections in the Thematic Guide.

[bookmark: _Toc426467282][bookmark: _Toc499734041]2.3. Memory sharing in real-time — TeamBase 
For documents in a project which are translated by two or more translators — who are either using DGT-OT or Studio — it is important to be able to share project memories in real time. With DGT-OT, the sharing is done via TeamBase which is managed via the DGT-OT Wizard.
A TeamBase memory is a bilingual memory that is created on a server and which receives — in real time —  a copy of each translated segment changed and validated by the translators connected to it in Read/Write mode. Both 100% and partial matches are immediately available to all the translators/revisers connected to a particular TeamBase memory.
You can connect to a TeamBase memory in Read mode only — in which case you receive segments from other colleagues, but do not send the segments you change and validate — or in Read/Write mode — in which case you receive segments from your colleagues connected to the same TeamBase memory in Read/Write mode and also send your segments.
[image: ]
[bookmark: _Toc426467283]
[bookmark: _Toc499734042]2.4. DGT-OT project structure
The DGT-OT projects are created by the Wizard locally in your computer as a subfolder in the C:\Users\{your login}\AppData\Local\DGT\OmegaT_Projects default folder.
The screenshot below shows the folder structure of a DGT-OT project created by the DGT-OT Wizard.

[image: ]

You can also create as many subfolders as you want inside the project folder  for example, to have monolingual reference documents which can be used for the Search Directory feature  or to gather any other information, either technical or administrative.
However you must not delete or change the name of any of the subfolders that were automatically created for each project. If you do, it may happen that DGT-OT will not work properly… or at all! 

[bookmark: _Toc426467284][bookmark: _Toc499734043]2.5. OmegaT_Projects folder
The OmegaT_Projects folder is created by the DGT‑OT Wizard — in the C:\Users\{your login}\AppData\Local\DGT\ folder — when DGT-OT is installed for the first time in your computer.
It is here that the DGT-OT projects are created by the Wizard as explained above.
When DGT-OT is first installed, the Wizard will also automatically create the following subfolders:
· _PROJECT-ARCHIVE (empty): Here you can store your finished projects just by dragging & dropping them from the main OmegaT_Projects folder so as not to have — over time — a long list of projects already finished. 
You can also simply delete finished projects as there is a copy of them in your H: drive (unless you delete them too!)
· _PROJECT-MEMORIES (empty): Here is (automatically) kept a copy of all the memories of the documents finalized with DGT‑OT and sent to Euramis via the DGT-OT Wizard.
Considering that Euramis strips all formatting from the segments it stores, it is very useful to be able to easily reuse memories of documents that you have finished using DGT-OT. Those memories are also sent to the Tradesk \Final folder of the respective document dossier.
For example, if new versions of already released — and heavily formatted — documents arrive later on, it would be a waste of time to reinsert all the formatting again… which is what you would have to do if you retrieved that document memory from Euramis. 
An alternative — and sometimes the best solution — is to update the old project with the new version.


· CONFIG-PERSONAL: Where you have all your preferences, memorized searches and dictionaries with learned and ignored words. This allows you to easily change them whenever you want. They are just text only files (UTF-8) that you can edit and change in Notepad++ or Wordpad. 
[image: ]
This folder is very important and you should be careful not to delete it as it contains files which store all your preferences so that — when you close and reopen the same or a different project — DGT-OT “remembers” your preferred settings and also some other information.
However, if you delete it by accident, the default preferences will be restored when you reopen the project in the DGT-OT Wizard… but you will lose your preferences.

[bookmark: _Toc499734044]2.6. Statistics
DGT-OT provides Statistics for the documents in your project and Match Statistics for the whole project and for each document, with the indication of repetitions in documents and between documents, something which is very useful, for example, if the documents in a project are to be translated (or split) between translators in the most efficient way. 
Getting Statistics is a fast process, but Match Statistics (per file) can take a while if you have a really big project (hundreds/thousands of pages) and/or many reference memories. However, as in DGT-OT the process is run in a background operation, you can start translating while the statistics are calculated. 
	STATISTICS
	MATCH STATISTICS
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MATCH STATISTICS PER FILE
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It also provides statistics in real-time of how many segments you have already translated and how many remain to be translated. Besides, it displays and continuously updates the number of (unique) translated/non translated segments, by document and for the whole project at the bottom right of the DGT-OT window. This gives an idea only of the number of segments translated/to be translated and is not the best measure. Of course you can at any time redo the Statistics and there you have the word and character counts.
[image: ]
	15/615
	Number of segments — translated vs. total for the current file

	14/551
	Number of unique segments — translated vs. total in the project

	615
	Total number of segments (including repeats) in the project

	123/146
	Number of source and target characters in the current segment


You also have automatically copied to your project main folder an empty Excel sheet template — OT_Stats{name of the project} — in which you can record manually your progress in the translation of your project, just by copying/pasting (option Keep text only) the data in the statistics given by DGT-OT as shown below. 
You can access this Excel sheet it via the DGT-OT Wizard, by clicking on Stats.

[image: ]

[bookmark: _Toc426467287]


[bookmark: Section3][bookmark: _Toc499734045]3. TRANSLATING/REVISING A (single or multi-document) PROJECT
After creating or updating a project — as explained in the Quick Reference Section and in more detail in Section 4 of this Quick Guide — you can open the project in the DGT-OT Wizard by clicking on Open.

[bookmark: _Toc499734046]3.1. Documents in the project 
All the documents in your project are, by default, automatically merged and treated as a single unit. 
DGT-OT numbers the segments sequentially from the first segment of the first document to the last segment of the last document, but it displays the name of each individual document in the Editor ribbon so that you always know what document you are working on. 
DGT-OT starts by displaying the list of the documents in your project. Click on Close to accept the opening of the first segment of the (first) document or select a different document before clicking on Close. 
If you are reopening a project you had already worked on, DGT-OT “remembers” the last segment you edited and will open it automatically in the Editor.
If you change your mind and want to translate a different document, just press Ctrl+L (or select Project Files in the Project menu) and the list will be displayed again and you can select the document you want by double-clicking on it. 
You can also change in this pane the order in which DGT-OT displays the documents in your project by highlighting the name of a document and clicking on Move First, Move Up, Move Down or Move Last.

[bookmark: _Toc499734047]3.2. Menus, DGT-icons and preferences
[image: ]
DGT-OT has 8 menus and several submenus. The more important menus for translation purposes are the Edit and Tools menu and also the View and Go To menus. You can customise many features — in a very simple way — in those menus. 
DGT-OT has also 23 icons for the most used features. 
For more information, see the list and explanation in Section 5 of this Quick Guide and, for in-depth information, see the relevant sections of the Thematic Guide.
Of course you can just accept all the defaults, but there are some preferences you may want to change right away.

[bookmark: _Toc499734048]3.2.1. Some menu preferences
1 — Menu View: 
· How the segments are displayed/highlighted (only target, also source, identification, etc.)
2 — Menu Options  Font: 
· Font type and size: by default Font: Dialog; Size: 14
3 — Menu Options  View Options:
· Include the first non-unique segment when marking non-unique menus: by default not activated
4 — Menu Options  Editing Behaviour Options:
· Minimal similarity (of automatic insertion of matches): by default 70% (there is no limit)
· Go to Next Untranslated Segment stops when there is at least one alternative translation: by default not activated
· Validate tags when leaving a segment: by default not activated

[bookmark: _Toc422822829][bookmark: _Toc427247174]
[bookmark: _Toc499734049]3.2.2. Layout — position and size of the panes
You can resize the different windows/panes as in other Windows application, by dragging the margins with the mouse. 
You can also undock and change the position of the different panes (Editor, Fuzzy Matches, Glossary, etc.). 
If you have changed the DGT-OT display and you don’t like it — and you feel at a loss — you can go back to the default display by selecting Restore Main Window in the Options menu.						[image: ]                                    [image: ]
	Minimize  Undock  Maximize                   Restore
Minimizing is done as in Windows by clicking on the respective icon at the top right side or right-clicking on the mouse and selecting the minimize option. 
Maximizing is done likewise by clicking at the top right side or right-clicking on the mouse and selecting that option. 
If you want to change the position of a pane, just click on the undock icon of the pane you want to move and, clicking on the blue header, drag it to the position you want (you will see a greyed area showing where the pane will be positioned). Release the mouse button when it is in the position and of the size you want.
To restore a minimized pane, select the pane at the bottom and click on the Restore icon and that pane will be displayed at its previous position.

[bookmark: _Toc499734050]3.2.3. Custom Colours
A new feature is that you can change the background and foreground colours to suit your preferences. 
In DGT-OmegaT, there are some differences in the default colour scheme compared to the standard OmegaT. If you change the colours, of course the list of codes in Section 3.3.3 may no longer apply.
[image: ]
If you are not happy with all the changes you made (too lousy as below!), you can either reset a particular colour or reset all colours. In that case you will go back to the DGT default colour scheme.
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[bookmark: _Toc499734051]3.3. Segment status and Translation and Revision Modes
When you open and translate/change/revise a segment, you validate it by pressing Enter, or pressing Ctrl+U (to Go To the Next Untranslated Segment in Translation Mode or to the Next Unrevised Segment in Revision mode), or scrolling and clicking on another segment, or leaving it in any other way and that segment acquires the translated status and is stored in the project memory (project_save.tmx in the project \omegat subfolder).
[bookmark: _Toc499734052]3.3.1. Segment status
In DGT-OT, segments have 3 statuses — untranslated and translated (last modified by) plus revised (last revised by).

	TRANSLATION LAST MODIFIED MARK
	TRANSLATION LAST MODIFIED AND LAST REVISED BY MARKS
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DGT-OT only keeps the translation of the segment as last modified (by the translator or the reviser) and Undo/Redo only works within the open segment… not for the whole document/project.
If you want to turn a translated into an untranslated segment, just highlight the text, delete it and move to another segment. 

[bookmark: _Toc499734053]3.3.2. Translation and Revision Modes
In DGT-OT, there are 2 Modes — Translation Mode and Revision Mode.
By default, when you open a project, you are always in Translation Mode. You can check it at the top of your project.
[image: ]
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You may ask why! The explanation is simple: in DGT-OT, you can mark a segment as revised, but you cannot delete the revision mark and make the segment “unrevised” again. 
To work in Revision Mode click on the blue REV icon [image: ]. 
You can work in Translation Mode and in Revision Mode in the same way, the only difference being that, if you are revising a project, you must click on the blue Rev icon before you (re)start revising… otherwise those segments will not be marked as revised.
Revision Mode:
When you work in Revision Mode the segments are marked as revised whether you change them or not.
If you forget to activate the Revision Mode — as long as you notice it in the same session (i.e. without closing and reopening the project) — just click on the Rev icon and press successively Ctrl+Shift+P (menu Go To — Back in History) or Ctrl+U (Next Unrevised Segment in Revision Mode in the Go To menu) to reopen all the segments you revised in Translation Mode and have them marked as revised.
If you are changing a segment and you want to see the changes you made — as compared to the translator’s segment — you can see the unrevised segment displayed first in the Fuzzy Matches pane identified as coming from the \tm\auto\draft subfolder, which is where the DGT-OT Wizard, when preparing a project for revision, stores the translator’s project memory.
If you close and reopen a changed revised segment or if you press Ctrl+S, that segment is again displayed in the Fuzzy Matches pane, but now with track‑changes in the target segment, thereby comparing your validated revised and changed segment with the unrevised translated segment.
You must use the Revision Mode if you are the reviser, but you can also use it when you are translating if you want to mark segments that you have revised yourself or if your translation will not be revised by anybody else. As in DGT-OT you cannot lock segments, this may be useful in some cases.
If you use it when translating — and your project will be revised by somebody else — in the DGT-OT Wizard, use the option in Translator — Send for revision with Omegat exports so that the reviser gets your project without revision marks. See the Section on Revision Workflow in this Quick Guide for details. For in-depth information on revision, see the relevant section in the Thematic Guide.

[bookmark: _Toc499734054]3.3.3. Segments — colour scheme
DGT-OT relies basically on a system of highlights and text colours to indicate segment status and other information. The Editor pane can become quite colourful as several colour codes will mingle! And furthermore now you can customize freely. 
Here is the key to the baseline colour scheme… when the relevant options are activated in the View menu.
	Segments in black are unique segments (1st segment).
Greyed segments are non-unique segments (2nd  segment) and the number of repetitions is displayed along the identification of the segment with date and translator login of last modification. 
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	Segments:
- Source with a blue background when translated
- Source with a light yellow background when not 
   translated
- Target with a light green background when
  validated
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	Segments already translated 
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	100% match from external memories with a green background
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	Below 100% match from external memories with a yellow background
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	Machine translation output with a grey background
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	The parts of the segment you change — either from MT output or fuzzy matches — are no longer displayed with a coloured background 
	[image: ]

	Auto-populated segments (from the \tm\auto files) are displayed with a light green background and with the date and the login of the translator, if available.
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	Segments with Notes are displayed with a pink background when the segment is closed.
A new feature is that URLs are clickable.
	[image: ]

	Segments are displayed with a red background when Marked Revised Segments is ticked in the View menu (used in the revision process)
	[image: ]




[bookmark: _Toc499734055]3.4. Editor display, Fuzzy Matches and Machine Translation 
In DGT-OT, there is always a segment open in the Editor. By default, when a project is open, it displays the first segment to be translated or the last segment you edited in the previous session with that project, if applicable.
For untranslated segments, when you open them, if there is a Euramis match above 70% (or a different threshold of your choosing), it will be automatically inserted in the segment open for translation and the match rate is displayed. If not, by default, machine translation output will be automatically inserted. You can change these options in the Options — Editing Behaviour submenu.
When you translate and validate a segment, it is saved to the project memory. If you open it again, that segment is, by default, identified with your login, date and hour in the Editor. These segments are not displayed in the Fuzzy Matches pane. Only below 100% matches from the project memory are displayed as Fuzzy Matches.
When you change the translation of a segment, the previous translation is discarded, which means that after validating the changed translation you cannot go back to a previous version of that target segment.
By default, segments in black are unique segments and — if already translated — are identified with "Translation last modified by {translator's login and date}" when you open them in the Editor. 
By default, greyed segments are non-unique segments (repetitions) and the number of repetitions is displayed along the identification of the number of the segment. 
All the segments in your project memory are identified with your login with the exception of pre-translated segments. 
If you use Pre-Translation — by adding a memory to the project tm\auto subfolder — your project memory will be “auto‑populated” with 100% match segments (including formatting) coming from the memory(ies) you copied to that subfolder. 
Those segments are identified in your project memory with the login recorded in the translation memory used for pre‑translation — which will probably be the login of another translator, if any — and are displayed with a light green background (default) in the Editor to indicate that they were pre-translated (“auto-populated”). 
Those segments will remain so identified in your project memory unless you open and change them. If you don’t change them, the segment identification will remain unchanged too.
When you Update a project with a new version of an original, there is no need to "pre-translate" as your translated segments are all in the project memory and are automatically displayed in the Editor (if they are 100% matches including tags) without any action on your part. If not 100% matches, they will be displayed in the Fuzzy Matches pane.
When revision is done in DGT-OT, the segments changed by the reviser have his/her login the field "Translation last modified by {in this case the reviser’s login and date}" as well as in the field "Translation last revised by”.
To insert in the target segment open in the Editor a Euramis match other than the first (higher) match displayed in bold in the Fuzzy Matches pane, position the cursor on the Fuzzy Match segment you want to use, double-click on it (which will turn to bold as the selected segment) and use the shortcuts Ctrl+R or Ctrl+I to insert it — in the segment open in the Editor — either replacing the text there, if any, or inserting it at the position of the cursor, respectively.
Also in the Fuzzy Matches pane, you can right-click the mouse and choose the option you want from the drop-down menu: Insert Match or Selection into Translation or Replace Translation with Match or Selection. With this feature, you can either insert the whole Fuzzy Match segment (highlighted in bold) or just a part of it if you highlighted just a part of that segment.
If you want to use Machine Translation (MT) (which is displayed in the MT pane) even when a Euramis match has been automatically inserted in the target segment, just press Ctrl+M to replace it by the MT output. If there is no fuzzy match within the defined threshold, DGT-OT will insert the MT output (default). 
You can deactivate the automatic insertion of MT in Options  Editing Behaviour, by unticking Insert Machine Translation. It is here that you can also select the Minimal Similarity threshold for the automatic insertion of fuzzy matches).
Copy/paste and drag/drop: You can use these feature between the Fuzzy Matches, Search, Glossary, Notes and Editor panes and from other applications.

[bookmark: _Toc499734056]3.5. Match rate displayed in the Fuzzy Matches pane and in the Editor 
There are three match estimates available:
· Match percentage (taking into account tokenizers)
· Default OmegaT match: number of matched words — with numerals and tags ignored — divided by the total word count 
· OmegaT match, including numbers and tags
Example: 100/91/95%. As you also have to guarantee that formatting will be correctly displayed in the documents in their native applications, always look at the lowest percentage. 
If you don’t see any difference in a below 100% match, it may be because there is a different formatting for the whole segment which is hidden, as DGT-OT only displays tags inside the segment, not formatting pertaining to the whole segment.
The Fuzzy Matches pane will display all the matches up to the maximum number defined in the External TMX Options menu (default: 10), even for low matches. This may be useful sometimes to see matches at subsegment level (typical cases are when the current sentence is part of a much larger sentence and vice-versa).

[bookmark: _Toc444875203][bookmark: _Toc499734057]3.6. Project memory and external translation memories
In DGT-OT, the project memory where all the segments you translate are stored is in the \omegat subfolder of your project. It is named project_save.tmx (with automatic backups to that same folder every 3 minutes and automatic backups to your space in the H: drive and to Tradesk’s \pret folder of the dossier of each document in the project every 30 minutes).
The other memories that you use in a project  retrievals and aligned reference documents  are considered external translation memories which are stored in the \tm subfolder of your project.
In DGT-OT, the machine translation files, which are also external translation memories, are stored in a different project subfolder  \mt  and are never mingled with human translation memories.
You can organize your external translation memories in ways that may save you a lot of time and help you achieve a higher level of consistency in your translation, mainly in the case of complex and/or large projects. You can:
a) Organize reference memories by subjects/subfolders and also assign different priorities
b) Assign penalties to memories or groups of memories
c) Pre-translate from external memories just by moving/coping them to the \tm\auto subfolder.
d) Translate with the help of a relay language from a reference memory with a different target language
However, if you want to see ongoing translations in other Language Departments, use the View Other Target Languages, which is automated.
For more information, see Section 4 on Managing DGT-OT Projects of this Quick Guide and the relevant sections in the Thematic Guide.

[bookmark: _Toc426467337][bookmark: _Toc444875231][bookmark: _Toc499734058]3.7. Tags, Tag Validation and Pseudo-Tags
In DGT-OT, tags are not displayed in "What You See Is What You Get" (WYSIWYG) mode. They are displayed in grey and do not indicate what type of formatting they represent, they are just numbered.
	TAGS
	PSEUDO-TAGS
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[bookmark: _GoBack]You can omit formatting that is present in the source segment taking care not to omit only one tag in the case of paired tags (bolds, italics, underlines) and not to omit tags for footnotes. When working with sdlxliff files, you cannot omit any tags!
To insert a tag, position the cursor where you want the tag to be inserted and press Ctrl+T. DGT-OT will insert the first or the next missing tag in that position. You can also right-click the mouse and choose the tag you want from the drop-down menu. 
Other options are: pressing Ctrl+Space to use the Auto-Completion feature to choose the tags in the dropdown menu (this is especially interesting for paired tags (bold, underline, italics)), clicking on Icon 15 to insert all missing tags at the position of the cursor or copy/paste or drag and drop the tag(s) from the source segment.
If, in the open target segment in the Editor you have a match with tags and you want to get rid of all the tags for some reason, press Ctrl+Shift+F5 (or select Strip tags in the Tools menu) to have the target segment cleaned of tags so that you can edit a “clean” segment… probably with different tags.
To add formatting not present in the source segment you can use the DGT-OT specific feature Format (pseudo-tags).
The pseudo-tags should be used sparingly only when there is no formatting in the source segment. This feature is still being tested, so check in the final translated document if there are no changes in font size or type after the pseudo-tags.
To insert these pseudo-tags, highlight the text you want to have in italics, bold, underline, superscript or subscript in the open target segment in the Editor, right-click the mouse, select Format and click on the formatting you want.
Important: If you are using the sdlxliff format, formatting (tags) not present in the source segment cannot be added in the target segment (neither in DGT-OT nor in Studio) as there may be problems.
After finishing your translation, or at any time during the translation process, click on the icon 16 (Validate tags) or press Ctrl+Shift+V (or select it in the Tools menu) and check if DGT-OT detected anything wrong/missing. By clicking on the number of the segment displayed on the left of the list, it will jump to the segment in question and open it in the Editor pane and you can correct it if needed. The Validate tags check is sometimes overcautious. There are tags that you may ignore... but others not! 
Tags not to be missed: a) footnote tags, as in that case the footnote will not be in the translated document; b) one of a pair of tags (bolds, italics, underlines); c) tags at the beginning of the segment or tags before and after a full stop in the middle of a segment (probably a segmentation problem or poor original). 
[bookmark: _Toc444875228]
[bookmark: _Toc499734059]3.8. Footnote segments 
Footnotes are treated as end notes and are always displayed at the end of each document (in multi-document projects). There is no visible "link" (besides a non-descriptive tag) between them and the respective paragraph. However, they will be correctly displayed in the translated documents… as long as you have inserted the respective tag in the relevant segment.

[bookmark: _Toc444875229][bookmark: _Toc499734060]3.9. Orphan segments  
These are segments that you already translated — and which are therefore in your project memory — but which no longer exist in the documents in your project. 
This may happen when you delete — for some reason — a document from your project or when you update a project with a newer version of one or more documents (and delete the previous version). 
These segments will be displayed in the Fuzzy Matches pane (with their match rate) and identified as “orphans”. They are displayed first according to the match rate.
 
[bookmark: _Toc499734061]3.10. Auto-propagation — Non-unique segments / alternative translations / default translation 
The first translation of a segment that appears 2 or more times in one or more documents in a project is automatically propagated in all the other repeated segments (non-unique segments) and DGT-OT considers it the default translation. These segments have the status “translated” and are counted as such in the statistics.
For projects with a substantial number of repeated (non-unique) segments, auto-propagation can be very interesting. 

However, it is important to understand how it works to take the best advantage of it as, in DGT-OT, by default, auto‑propagation is done for the whole project — both backwards and forwards — in a background operation you don’t see… but also without any “warning”! 
[image: ]

So, take into consideration that if you change the translation in any one of the segment’s occurrences, all the other identical segments (in all the project documents) will be automatically and instantaneously changed without any need for confirmation or search, search/replace on our part. 
The number of repetitions is indicated after the segment number as +X more and, by right-clicking the mouse, you will see the list with the numbers of the other repeated segments (if more than 5, click on Duplicate segments to see the list). 
If you click on one of the numbers, DGT-OT jumps to that segment in the Editor and opens it for editing.
You can choose to also have the first occurrence of that segment greyed — to call your attention to the fact that it will be repeated further on in your project — instead of having it greyed only in its second occurrence (default) — by selecting that option in the View  View Option submenu. 
But, if you want the translation of a particular occurrence of a non-unique segment to be different and not changed automatically if any other of its occurrences is changed, you can define it as an alternative translation — just by right-clicking the target segment or selecting it in the Edit menu. This way you dissociate it from the other occurrences of that non-unique source segment by linking it to its respective previous and next segments.
In case there are, for example, 10 occurrences of that non-unique segment, the other 9 occurrences will continue to be associated and will remain auto‑propagated with the default translation. You can also at any time change the default translation and all the 9 occurrences will be instantaneously changed too. The segment with the alternative translation will remain unchanged, of course.
For segments with one or more alternative translations, the default translation and the alternative translation(s) are displayed in the Multiple Translations pane: first the default translation and after that the alternative translation(s) with the indication of the previous and next segment for each of them.
[image: ]
If you want to deactivate auto-propagation, just untick the option Auto-Propagation of Translations in the Project — Properties submenu.
[bookmark: _Toc426467336][bookmark: _Toc444875230]
[bookmark: _Toc499734062]3.11. Merging and splitting segments/segmentation 
DGT-OT does not allow to easily merge or split segments in the Editor. It can be done but it is not straightforward. 
If you have a really poor original in terms of formatting, you can — in the original document copied to the Dossiers folder in your computer  — correct it, save it and Update the project with that corrected original. Of course the original in Tradesk will remain untouched. 
This has the advantage that you can even merge different paragraphs!
If you are using the sdlxliff format, this cannot be done … obviously.


[bookmark: _Toc499734063]3.12. View Source or Target File 
To view the Source File, press Ctrl+H — or select View Source File in the Project menu.
If you want to view the document you are currently translating, press Ctrl+G — or select View Target File in the Project menu — and DGT-OT will generate the active translated document and display it in its native application.
If you have one or more translated documents open in their native application, the operation cannot be completed. So, don’t forget to close all those documents before generating translated documents with this feature or creating the translated document(s) (Ctrl+D and Ctrl+Shift+D).
This also works for sdlxliff files as DGT-OT connects to Studio, generates the target document(s) and saves them in the \target-native subfolder of your DGT-OTproject.

[bookmark: _Toc499734064]3.13. Open project in Studio
This is a new feature. If you are using sdlxliff as the source format (either for translation or revision) you can open in Studio the project of your DGT-OT active document and, if you wish, continue to work in Studio and even go back to using DGT-OT again.
However, be very careful. If you open the project in Studio and make changes in it they will not be transferred to the DGT-OT project. 
This feature is still being tested. If you use it and if you have problems, shout for help!

[bookmark: _Toc499734065]3.14. View Other Target Languages 
To use this in-house feature to see ongoing translations by colleagues from other Language Departments, just click on the blue icon [image: ], select the language and click on the option you want. 
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It will be immediately displayed when you open the next segment, unless there is a message saying that there is no sdlxliff file available for that language. 
You can have one or more other target languages displayed: 
a)	In the Editor, as another source language (for segments without tags), by selecting the option Import tmx2source;
b)	In the Fuzzy Matches pane (for segments with tags), by selecting the option Import TM/penalty-50 (so that you have those segments displayed with a 50% penalty); 
c)	As a bilingual html file with original and chosen target language side by side, by selecting the option View HTML. 
You can use any combination of these displays.

[bookmark: _Toc426467304][bookmark: _Toc444875188][bookmark: _Toc499734066]3.15. Print 
You cannot print the document as seen in the Editor, you can only print the translated document after generating it with either of these commands: Ctrl+G or Ctrl(+Shift)+D. 

[bookmark: _Toc499734067]3.16. Create Translated Documents or Current Document 
To create the translated document(s) in their native application(s), press Ctrl+D to generate all the target documents or Ctrl+Shift+D to generate only the document you are working on. They are generated in the project \target subfolder. 
It is better to do Validate tags before creating one or more translated documents (and before viewing target files). If you don’t, DGT-OT will generate the document(s) anyway — potentially without formatting or footnotes. In case the generated document(s) is/are corrupted —essential tag(s) missing (see Section 3.7 above) — use the Validate tags command to correct the issues and generate the document(s) again.
You can generate the formatted document as many times as you want, taking into consideration that any changes you make directly (formatting or content) in the generated target document will not be transferred to the DGT-OT project memory.
Every time you repeat the Create (Current) Translated Document(s) or View target file command, DGT-OT deletes all the files in the whole \target subfolder and hence will replace any previously generated document(s) with the updated one(s). 

So don't make any changes in the document(s) in their native application unless you are sure you won't use DGT-OT again for the translation of that particular document.
If you are working on a project with a (large) number of documents and/or with different deadlines — and you make changes in it/them directly — it may be “wise” to create a new subfolder in your project and save your document(s) generated in the project \target subfolder to that new subfolder so that they are not replaced by any subsequent creation of translated documents. 
So it is not recommended to change a document in its target application without uploading it to Tradesk.


[bookmark: _Toc499734068]3.17. Search in DGT databases 
To use DocFinder, Quest, Euramis or IATE, just highlight the term/string/OJ reference you want to search and click on the icons or use the shortcuts (Ctlr+Shift+F, Ctlr+Shift+Q, Ctlr+Shift+E or Ctrl+Shift+L, respectively).
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[bookmark: _Toc499734069]3.18. Search (Concordance) and Filter
It is really worth exploring the powerful Search feature. For detailed information, see the sections in the Thematic Guide.
To search terms/strings in the project and/or the reference translation memories and/or glossaries and or/notes, highlight them in the Editor pane, press Ctrl+F and Enter to accept the defaults  or press Ctrl+F, select the setting(s) you want in the Search window and press Enter. DGT-OT will search for terms according to the settings. 
You can search — by exact search, keyword search and regular expressions, strings, whole words and lemmas; use the Boolean operators AND, OR and AND+NOT; search by regular expressions, by author/translator, by date — in source or/and target segments in your project (translated and/or untranslated) and/or in the translation memories and/or in glossaries and notes. 

[image: ]
[image: ]
If you don't need the advanced options, you can hide a part of the Search view (highlighted in green above) to have more space for the results.
[bookmark: _Toc444875250][bookmark: _Toc444875247]To go back to the last edited segment (before the filter was activated, for example), in the Text Search window, click on Close and DGT-OT will open that last edited segment in the Editor. Check that the option Back to the initial segment on close at the bottom of the Text Search window is ticked (by default unticked).
You can also Auto-Sync with the Editor by clicking on this option at the bottom of the Search window. Then the active segment in the Search pane opens automatically in the Editor (provided it comes from the project memory, of course). The active segment is displayed with a green background (starts with first of the list; you can click on any other). By default, this option is unticked. 
For a number of settings, you can also memorize searches to be reused. You can memorize your searched terms by ticking the box Memorize in the field you want and selecting if you want to memorize the term/expression only For the current session (i.e., it will be deleted after you close the project), For the project (and thereby having it available for that project no matter how many times you close and reopen it) or For all the projects you translate using DGT-OT. 
This feature is available for the fields: In Source, In translation, In notes, File or folder name, Author and Translator.




[bookmark: _Toc499734070]3.18.1. Search combining Expression and Word modes
In DGT-OT, the Search feature has been redesigned and improved and you have — besides the Expression mode options — the Word mode options which you can associate to widen or limit the search results depending on your needs.
If you are wondering why there are so many Search options, let’s look at the examples below — where there is not only a word but also 2 strings of words to be searched — just for you to have an idea of the kind of results you can get — and how best to use this feature for each particular case restricting or broadening your search! 
SEARCH WITH EXPRESSION MODE “EXACT SEARCH” and THE 3 WORD MODES
	
TERM
	
EXACT SEARCH + STRING
	
EXACT SEARCH + 
WHOLE WORDS
	
EXACT SEARCH + LEMMAS

	
	Results
	No.
	Results
	No.
	Results
	No

	withdrawal
	1. withdrawal
2. Withdrawals
	102
	1. withdrawal
	88
	1. withdrawal
2. withdrawals
3. withdraw
4. withdrawing
	192

	arbitration panel ruling
	1. arbitration panel rulings
2. arbitration panel ruling
	187
	1. arbitration panel ruling
	179
	1. arbitration panel ruling
2. arbitration panel rulings
3. arbitration panel to rule
4. arbitration panel rules
	250

	equal treatment 
	1. equal treatment
2. unequal treatment
	48
	1. equal treatment
	45
	1. equal treatment
	45



SEARCH WITH EXPRESSION MODE “KEYWORD SEARCH” and THE 3 WORD MODES
	
TERM
	
KEYWORD SEARCH + STRINGS
	
KEYWORD SEARCH + WHOLE WORDS
	
KEYWORD SEARCH + LEMMAS

	
	Results
	No
	Results
	No
	Results
	No.

	Withdrawal
	1. withdrawal
2. Withdrawals
	102
	1. withdrawal
	88
	1. withdrawal
2. withdrawals
3. withdraw
4. withdrawing
	192

	arbitration panel ruling
	1. arbitration panel ruling
2. arbitration panel rulings
3. arbitration panel to rule
4. arbitration panel rules
5. rulings of the arbitration
    panel
6. arbitration panel
   decisions and rulings
	419
	1. arbitration panel ruling
2. arbitration panel ...ruling
3. ruling of the arbitration 
   panel
	378
	1. arbitration panel ruling
2. arbitration panel rulings
3. arbitration panel to rule
4. arbitration panel rules
5. rulings of the arbitration panel
6. arbitration panel decisions and rulings
7. arbitration panel… Rules of Procedure
8. arbitration panels ...customary rules
	537

	equal treatment 
	1. equal treatment
2. unequal treatment
3. its treatment is equal
	51
	1. equal treatment
2. its treatment is equal
	47
	1. equal treatment
2. equality of treatment
3. its treatment is equal
	48



So, the options available are:
· Expression mode: Exact search, Keyword search, Regular expressions; 
· Word mode: Strings, Whole words and Lemmas;
· Case sensitive.
The Expression mode describes how the succession of words (separated by spaces) is considered:
· Exact search: the words must all be in the text and in the same order, i.e. you look exclusively for the entire query string;
· Keywords: all words must be present, so "one example" also returns segments with phrases like "one more example" "the example shown is a good one". In other words, you look for all the words in the query independently of the order in which they appear in the segments being searched;
· Regular Expression: what is in the fields is not necessarily words but one or more regular expressions.
For the Exact Search and Keywords options, you can then decide how each word will be considered individually. You have 3 Word mode options — String, Whole Words and Lemmas.


[bookmark: _Toc499734071]3.18.2. Filter
In fact, the Search feature itself is already a filter as you can limit the search in several ways. 
So filtering in DGT-OT really refers to the editing of the searched terms/strings in the project memory and therefore it is — obviously — only applicable to searches in the document(s) you are translating.
With it you can, in a single operation, search for words/strings/regular expressions using the search results and filter those segments for editing. 
Just click on Filter at the bottom of the Search window and those segments will be displayed in the Editor and you can modify them. To return to the full document and continue working normally in the Editor, click on Remove filter. 

[bookmark: _Toc499734072]3.18.3. Limiting the search to one external memory or a group of external memories
You can also limit the search to a subfolder or an external translation memory in the \tm folder, something which can be very useful if you have lots of reference memories. Just tick the box File or Folder Name and copy the name of the reference to that field. You can also memorize it for further use.
If it is a search limited to a single file, you must copy the full name of the file (path included if it is a file in a subfolder of the \tm folder) and extension. For example: 2‑MAIN‑LEGISLATION\NoDG-2011-32011D0263_EN-PT-DWN.tmx. 
Using the same example, if you want to search in the whole subfolder and not only in one of the translation memories in that subfolder, you just have to copy the name of the folder — in this case 2-MAIN-LEGISLATION.

[bookmark: _Toc444875249][bookmark: _Toc499734073]3.18.4. Regular Expressions
In theoretical computer science and formal language theory, a regular expression (abbreviated Regex or RegExp) is a sequence of characters that forms a search pattern, mainly for use in "find and replace"-like operations. 
In DGT-OT, you can use RegExes in Search Project, Search Directory, Search and Replace and Search and Pre-Translate. Regular Expressions can be very useful if you know how to use them... and if you are careful!
They work only in string mode, implicitly. For that reason, when you select that option, the Words mode box disappears and new options are displayed: Partial segment, Whole words and Full segment.
When DGT-OT is installed, some RexExp are already memorized and readily available in the In field in the Search window. 
So, to use them, just select Regular Expression in the Expression Mode and on [image: ] (highlighted in green below) to view the already memorized RegExes. For a list and explanation, see Section 5 of this Quick Guide.
[image: ]
The Regular Expressions are saved in a search.tsv file in the _CONFIG-PERSONAL subfolder in the OmegaT_Projects folder and you can add and save other Regexes. 
They are saved in a txt file that — as almost always in DGT-OT — you can edit, for instance to delete memorized terms that you no longer need. 



[bookmark: _Toc499734074]3.19. Search/Replace
You can Search / Replace all or one by one (Replace Interactive) by pressing Ctrl+K or clicking on Search and Replace in the Edit menu. You can do it in all the documents of your project using the same options as in Search text (exact search, keyword search, regular expression, case sensitive, strings, whole words and lemmas) and “preview” the segments affected before launching the replacement operation.
As DGT-OT has no Undo feature (except for text in the segment open in the Editor), it is advisable to save (Ctrl+S) before launching a Replace all action so that, if you make a BIG mistake, you can go back in a fairly easy way. See Section 7 on Troubleshooting. 

[bookmark: _Toc426467344][bookmark: _Toc444875252][image: ]


[bookmark: _Toc499734075]3.20. Search in monolingual reference documents 
With Search Directory (in the Edit menu) or by pressing Ctrl+Shift+K you can also search monolingual documents in the formats accepted by DGT-OT (e.g. Office and PDF). This may be very useful when you have documents — for example, national legislation, standards — that are relevant to your project. 
 [image: ]


[bookmark: _Toc499734076]3.21. Search and Pre-Translate
DGT-OT allows you to Search by some criteria and Pre-translate the resulting segments — either copying source to target or pre-translating them using the external memories or machine translation output. Just press Ctrl+Shift+Z or choose that option in the Edit menu.
As with the Search and Replace feature, DGT-OT displays a “preview” of the segments affected and you can check if that is really what you want before launching the replacement operation.
Again, as DGT-OT has no Undo feature (except for text inside an open segment in the Editor), it is advisable to save (Ctrl+S) before launching this operation so that, if you make a BIG mistake, you can go back in a fairly easy way. See Section 7 on Troubleshooting.
One of the options — Translate as Source — can be very useful when you have documents with hundreds or thousands of segments only with numbers that you may want to translate in a batch to have them counted as translated in the statistics… and to automatically Go To the Next Untranslated segment without stopping in those segments.
[image: ]
In the example above, there were almost 5 700 segments (out of 18 000 segments) which were numbers (positions of the EU Combined Nomenclature). With this feature, in a few seconds, all those segments were pre‑translated (by copying the source to the target segments) using the regular expression ^[^a-zA-Z]*$ (one RegEx that is memorized by default for the In field in the Search window; you can copy it from there). 


[bookmark: _Toc499734077]3.22. Glossaries
	[image: ]
	[image: ]


In DGT-OT, you can have one or more read-only glossaries and one — and only one — writable glossary. 


By default, when you create a DGT-OT project using the Wizard, an IATE extraction will be automatically generated and saved in the project \glossary subfolder. 
The terms/strings with a blue linear and bold underline (by default) in the open segment in the Editor mean that there is an entry in one of the glossaries in the \glossary folder of your project. By right‑clicking the mouse, the translation(s) of that term/string will be displayed in a dropdown menu. 
Entries from all the glossaries are displayed in the Glossary pane, in the TransTips dropdown menu and via the Auto‑complete.
To create a glossary entry in the project writable glossary, highlight the source term you want and press Ctrl+Shift+G (or go to the Edit menu and click on Create Glossary Entry) and fill in at least the first 2 of the 3 fields available (source term, target term and comments). 
If it is the first entry you create in that project — and you have no previous writable glossary in the \glossary folder of your project (default situation) — DGT-OT will automatically create a glossary for that project. 
If you want to delete or change an entry in this glossary — called the writable glossary — press Ctrl+Shift+F2 (or select that option in the Tools menu) to open the glossary in Notepad++ or any other default text editor for editing.
The DGT-OT glossaries are txt files (UTF-8) with 3 fields separated by tabs and ended by a carriage return (the last field is optional): 
            Source term<tab>Target term<tab>3rd field with whatever you like or empty<Return>
Be careful to keep that structure when you make changes manually in this file. Don't forget to save the file after changing it.
A new OmegaT feature is that links are now clickable in the Glossary, as well as in the Notes and Comments panes.
[image: ]

[bookmark: _Toc444875258]
[bookmark: _Toc499734078]3.23. Notes in translated documents 
You can have notes linked to particular segments in your document which are displayed in the Notes pane when that segment is open. When closed, those segments are, by default, highlighted with a background colour in the Editor. 
[image: ]


Neither this highlight nor the actual notes will be transferred to the document(s) in their native applications. However, you can export all your notes to a file, if you want to send them to a colleague/terminologist/reviser.
A new feature in this OmegaT version, is that if you copy links to the Notes they will be clickable (as shown in the Screenshot in the previous Section).
Furthermore, now you can use Undo and Redo inside the Notes

To generate a list of your notes (note, source and target segments), press Ctrl+Shift+F6 or select the Write Notes to File option in the Tools — Scripting menu. 
DGT-OT will save this file in a (new) script_out subfolder in your project folder in xml format. If you want to edit it, just highlight and copy the table to a Word file and save it wherever you want.
Every time you launch this operation, DGT-OT will replace the file in the script_out subfolder by the update. So, if you want to keep that list for further reference, just rename it.
[image: ]

[bookmark: _Toc499734079]3.24. Auto-completion 
The Auto-Completion feature allows you to complete words from glossaries or from auto-text (your own list of abbreviations), to insert (special/foreign language) characters and also to insert tags by pressing Ctrl+Space and cycling through the options with Ctrl+Page Up/Down. 
For detailed information, see the relevant section in the Thematic Guide.
You can customize the display of the Auto‑completion options, namely of the Character Table and you can add entries to Auto-text.

	Glossary entries
	Auto-text entries

	[image: ]
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	Missing tags
	Character table
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To use the Auto-Completion feature, press Ctrl+space and cycle through the options by pressing Ctrl+Page Down/Page Up to select the option you want. 
To add a new entry for Auto-text (abbreviation), select Options  Auto-completion  Auto-text and add your new entry. 
To add a character to the custom Character Table (characters that you most frequently use), select Options  Auto-completion  Character table.
If you press Ctrl+space, the Auto-completion is permanently displayed (as a kind of auto-suggest) — either from the project glossary(ies) or from Auto-Text as you prefer. 
To deactivate it, select Options  Auto-completion  Show automatically when relevant and untick that box.
Alt Codes (non-breaking space, etc.): For a non-breaking space type Alt 255 or Alt 0160, for a non‑breaking hyphen Alt 0173, for a n-dash Alt 0150, for a m-dash Alt 0151 and for a quotation dash/horizontal bar Alt 196. For more codes, see List of Alt Key Code Symbols and Characters and AINSI Codes. 
You can select symbols/characters from the Auto-completion  Character table or add them to the Auto-text list to easily insert them. 
There is a new feature in this updated version of OmegaT: the History Completer. 
[image: ]

With this feature – and depending on your preferences – you can have suggestions (automatically or not) displayed when there are no suggestions from glossaries or auto-text:
· Histoty Completions: As you type a word, this view suggests completions from words found in existing ranslations in the current project.
· History Predictions: This view suggests words that have appeared elsewhere in the current project following the previous word. The suggestions are sorted by frequency of use.

	History Completions
	History Predictions
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[bookmark: _Toc499734080]3.25. Spellcheck, Language Checker and Quality Assurance
DGT-OT uses the LibreOffice dictionaries for the spellchecking and language checker features.
You can spellcheck your whole project by clicking on Ctrl+Shift+F7 or selecting the spellchecker in the Tools menu.
You can also add learned or ignored words one by one by right clicking on the mouse and selecting Ignore all or Add to dictionary.
You can also do a quality check of your project — QA Check Rules — by clicking on Ctrl+Shift+F3 or selecting it in the Tools menu. You can choose the type of “errors” you want to detect by ticking/unticking each box.
	SPELLCHECK
	QUALITY ASSURANCE
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When DGT-OT is installed, all the dictionaries for the EU official languages are automatically installed and are used for spellchecking your documents, according to the target language selected when you created the project.
The Dictionary file folder is: C:\PGM\DGTapps\CAT2016\OmegaT\SPELLERS\Both,${user.home}\AppData\Local\DGT\OmegaT_Projects\_CONFIG-PERSONAL, so that it will use the LibreOffice dictionaries and any list of words for targets languages that you may have in the _CONFIG-PERSONAL folder.
You can, in the Options — Spellchecking — Spellchecker Setup, tick/untick the automatic checking of spelling of text. And you can also install new dictionaries. For more detailed information, see the Thematic Guide.




[bookmark: Section4][bookmark: _Toc426467288]


[bookmark: _Toc499734081]4. MANAGING DGT-OT PROJECTS
Here more information is presented on how to manage DGT-OT projects. For in-depth and step by step information, see the relevant sections in the Thematic Guide.
The starting point to create (or update) a project with one or several documents (with the same or different dossier numbers) is always to use the Local copies option in Tradesk to copy to your computer the original documents to be included in the project. 
By default, they are copied to the C:\Users\{your login}\AppData\Local\Local Documents — no backup\DGT\Dossiers folder). 
To manage your project, you can click on the buttons or use the shortcuts (ALT + character underlined, for example ALT+A).
Note: 	If the first character of each option is not underlined, just click on Alt to activate the shortcuts.
As DGT-OT does not accept the Windows 2003 formats, if you have an “old” document still in that format, either use the ORC document in Tradesk (if it is a Word document) or open that/those document(s) in their native application and Save as in the new format (docx, xlsx, pptx) before creating the project.
To manage projects already created, you can also use:
a) The new OmegaT feature Access Project Contents to open the project folder (Root) or its subfolders.
[image: ]

b) The Open Project Folder (Ctrl+Shift+F1) feature of DGT-OT that enables you to access the project folder from within DGT-OT, opening it in Windows Explorer or 
c) Open a Windows Explorer window — if you have local files in your computer you want to copy to your project — and drag&drop them to the relevant panes in DGT-OT:
i) External memories (tmx) (retrievals and reference documents) to the Fuzzy Matches pane
ii) Machine translation file(s) to the Machine Translation pane
iii) Glossaries to the Glossary pane and 
iv) Original documents to the Editor pane (in the case of docx files, without TagWipe). 
You will see that the panes become greyed. It means that those files were copied to the relevant project subfolders. 




[bookmark: Section4_1][bookmark: _Toc499734082]4.1. Creating a new (single or multi-document) project
1 –	In Tradesk, make a Local copy of the original documents (2010 Office format ) to your computer. 
	They will be automatically copied to the Dossiers folder (C:\Users\{your login}\AppData\Local\Local Documents-no backup\DGT\Dossiers). Make this location a Favourite in Windows Explorer!
2 –	Click on the DGT-OT Wizard icon in your desktop (automatically created in the installation of DGT-OT) to open it.
	If it is not your first project, select Clear before starting the creation process.
3 –	Select the source and target languages from the dropdown menu (if not already defined).
[bookmark: Section4_1_4]4 –	Click on Add — which by default will open a Windows Explorer window in the Dossiers folder — to select the folder where the original document(s) previously copied to your computer are. 
	You can select one, several/all in a same folder as is usually done in Windows Explorer (with Ctrl+Shift, if several) and press Enter. 
	If they are in different folders, navigate the folder structure to reach and select all the original documents. You will see in the Wizard window the list of documents you have selected. 
5 –	By default, the DGT-OT Wizard will give to the new project the name of the first document you added to the list, but you can change it — in the Project field — writing any name meaningful to you.
6 –	Click on Create and, by default, the DGT-OT Wizard will create the project with:
a) All the original documents you selected copied to the \source subfolder (processed by TagWipe if docx), 
b) All the translation memories (tmx) relevant for your language combination in Tradesk to the \tm subfolder, 
c) All the Machine Translation files relevant for your language combination to the \mt subfolder and 
d) An IATE extraction to the \glossary subfolder. 
	If you do not want the IATE extraction for some reason, untick the IATE option before creating the project.
7 –	Click on Open (which will become green once the project has been created) and it will open that project in DGT-OT. 

[bookmark: _Toc499734083]4.2. Creating a new project with confidential documents (SECEM)
The process is the same as in the previous section with the only difference that you must, before clicking on Create, tick the SECEM box in the DGT-OT Wizard and the Wizard will create the project in a subfolder of the OmegaT_Projects folder (_SECEM).
As SECEM documents are subject to certain restrictions, namely that they cannot be sent over the network and must not be kept on a server or other shared place, except in the secured Tradesk environment, you will have to manually copy to your computer the original(s), as well as the retrievals, reference documents and machine translation files, if any, from the secured Tradesk space to which you have access. 
As the automatic backups are switched off, you will have to do backups of your project manually. If there are new versions/documents to be included in the project, you can use the Update feature to update the project, but you will have again to copy all the memory files manually.
If, during the translation of the project, those documents are no longer confidential, you can just close the project, drag&drop it to the main OmegaT_Projects folder and, after unticking the SECEM box in the Wizard, open the project again. It will become a "normal" project with automatic backups and copies of the project memory to Tradesk.

[bookmark: _Toc426467355][bookmark: _Toc499734084]4.3. Translation and revision with sdlxliff files – being tested 
This is a new feature in DGT-OmegaT that is still being tested. However, as it can be very useful, namely for the revision of freelance translations, it is made available in this new version, even if the workflow is not automated and therefore some operations have to be done manually. 
In DGT-OT, you can work as usual, the only difference being that the tags are in a different format and numbered by paragraph (as usual in DGT-OT) and not sequentially as in Studio. This is done via a new DGT-specific filter which renumbers tags by paragraph and, when generating the target file, re-renumbers them sequentially to be read in Studio. This way, auto‑propagation in DGT-OT, which is an important feature for some projects, is maintained.
If you want to try/use it and if you have problems, just shout for help! 

[bookmark: _Toc499734085]4.3.1. Translation in DGT-OT and eventually revision in Studio
As the workflow is not automated yet, you will have to create the project(s) for the documents you want to translate using the Studio CAT Client. At this stage, we advise you to create single-document projects in Studio even if it already allows the creation of multi-document projects.
So, to create a DGT-OmegaT project with sdlxliff document(s), follow the steps indicated in Section 4.1, only adding the following steps:
1 – Create the Studio project(s) using the CAT Client
2 – In Studio, open each project and generate the target document
3 – In the DGT-OmegaT Wizard, click on the sdlxliff box
4 – Select the file(s), not in the \Dossiers folder in your computer but in the target folder of the Studio project(s) which are in the C:\Users\machame\AppData\Local\Local Documents - no backup\DGT\Translation Projects folder in your computer.
The rest is the same.
If the project is to be revised in Studio, when you have the translation ready to be sent to the reviser:
a) In DGT-OT - in the Project menu - click on Open in Trados Studio to send the document displayed in the Editor to Studio.
b) The project is open in Studio and you can proceed as usual and send it to the reviser via the CAT Client
c) After it has been revised in Studio, get the revised project back via the CAT Client and finalize it in Studio, as that is the simplest way.

[bookmark: _Toc499734086]4.3.2. Revision and finalization of freelance sdlxliff translated files in DGT-OT 
To create a DGT-OmegaT project with freelance sdlxliff translated file(s) for revision in DGT-OT:
1 – In Tradesk, copy the relevant translated sdlxliff file(s) to your computer
2 – In the DGT-OT Wizard, click on the sdlxliff box
3 – Create the DGT-OT project as usual via the DGT-OT Wizard but selecting the sdlxliff translated file you copied to your computer.
You can revised as usual in DGT-OT and finalize it using the DGT-OT Wizard.

[bookmark: _Toc499734087]4.3.3. Revision in DGT-OT of in-house sdlxliff translations done in Studio and finalization in Studio
To revise in DGT-OT one or several documents translated in Studio:
1 – In the CAT Client, get the project(s) for review.
2 – In the DGT-OT Wizard, create a single or multi-document project with the target file(s) in the relevant Studio project(s) which are in the C:\Users\machame\AppData\Local\Local Documents - no backup\DGT\Review Projects folder in your computer.
3 – Open the project as usual in DGT-OmegaT and use the Revision mode as usual. 
If you have the last word and finalize the project, just do as usual using DGT-OT and its Wizard.
4 - If you want to send the project back to the translator for finalization, there are some manipulations that you have to do:
a) In DGT-OT, in Tools, run the script 11 - Calculate sdlxliff differences and select the document(s) you want to send to the translator if there are more than one.
b) Open the DGT-OT project folder and copy the sdlxliff target file(s) in the project sdlxliff-compare subfolder to the target subfolder of the relevant Studio project(s) (opening the relevant Studio project folder(s) in the CAT Client)
c) Send the reviewed project as usual to the translator via the CAT Client.


[bookmark: _Toc499734088]4.4. Updating a project with new documents/versions or translation memories
You can add at any time new documents or versions of documents — or translation memories available in Tradesk — to a project in a simple way without the need to create a new project. The process is basically the same as when you create a new project.
When you reopen the updated project, the segments you already translated — which are stored in the project memory — are automatically inserted in the new document/version of your document(s) if there is a 100% match (including tags), without any action on your part. The partial matches will be displayed in the Fuzzy Matches pane as ‘orphan’ segments.
After making a local copy of the originals to your computer:
1 –	If DGT-OT is open, close it, select the project to be updated by clicking on Select, if it is not the active project and 	check that the source and target languages are correct. 
2 –	Click on Add — which will open a Windows Explorer window — to select the original document(s) that you previously copied to your computer in the same way as when first selecting documents to create a new project (see Section 4.1, point 4). 
	If you are just adding reference translation memories (tmx) in the meantime available in Tradesk, select the documents to which those memories are linked, i.e., in case of a project with several parts of a Tradesk dossier, it is enough to select just one of the documents as all the memories will be copied to your project.
3 –	If new version(s) of existing document(s) are added, in the DGT-OT Wizard click on Browse, select the \source subfolder and delete the previous version of the original document(s) if no longer needed (usual situation). 
4 –	Click on Update and afterwards on Open when the update is finished and the DGT-OT Wizard will open DGT-OT and that particular project. 

[bookmark: _Toc499734089]4.5. (Re)create a project partially translated by a colleague
In all projects translated with DGT-OT, a copy of the project memory (draft) is sent by the DGT-Wizard every 30 minutes to the Tradesk \pret folder of the relevant dossier(s), renamed {document name}-DRAFT-{translator login}.
Therefore, if you have to continue translating a project started by another translator who, for some reason, is not available to transfer the project to you, you can easily (re)create that project from scratch as the work already done by your colleague — backed-up in \pret folder of Tradesk — is automatically copied to your new project to the \tm subfolder.
So, in the DGT-OT Wizard, you just have to:
1 — 	Create a new project as explained in Section 4.1.
2 -	Click on Browse to open the project folder in Windows Explorer.
3 -	Click on the \tm subfolder name and move the {document name}-DRAFT-{translator login} file to the \tm\auto subfolder and all the segments already translated by your colleague (100% match including tags) will be displayed in the Editor, highlighted in orange if you have the option Mark Auto-Populated Segments activated in the View menu.

In case of multi-document projects, you will have several DRAFT memories with the name of each of the documents in the project (and identified with the login of the translator). However, as all those memories are identical (in fact they are a copy of the project_save.tmx of your colleague), just move one to the \tm\auto folder and you can delete the others.
If there are DRAFT memories with different logins, then it means that there are/were several translators working on the project documents. In that case, use the DRAFT memories you need for your particular project.



[bookmark: _Toc499734090]4.6. Sending (ongoing or finalized) translated documents to Tradesk (in batch)
In the DGT-OT Wizard, sending documents (in batch) to Tradesk has been automated as far as possible as in multi‑document projects there may be documents in different stages in the translation and/or revision process.
[image: ]

Therefore, it is always up to you to select the document(s) you want to (re)send to Tradesk and, if you have already sent it/them before, the DGT-OT Wizard will ask you to confirm that you want to replace it/them.
In multi-document projects, be careful, especially if you have already edited one or more documents in Word!
To send ongoing or finalized translated document(s) (in a batch operation for multi-document projects) to Tradesk at any moment during the translation process:
1 –	In DGT-OT, create all the translated document(s) with Ctrl+D or the current translated document with Ctrl+Shift+D.
	You can also View the Target File (Ctrl+G) to check the document displayed in DGT-OT in its native application. You can also save it to another location in your project folder (for example: a new folder translation-released). In both cases, close it before proceeding to the next step.
2 –	In the DGT-OT Wizard, click on Euramis/Tradesk — Send and you will see in the window the list of documents which will be sent to Tradesk. Watch the dialog box below to know what the Wizard is going to do!
3 –	To send the documents to Tradesk, either:
a) Accept the documents displayed by default if you want to send the one(s) you last generated and which is/are in the project \target subfolder.
b) If there are several documents displayed and you don't want to send them all to Tradesk, highlight, one by one, the name of the document(s) you don't want to send to Tradesk and click on Remove.
c) If you have the translated document(s) in another project subfolder click on Clear and then on Add, navigate the project subfolder structure and select the subfolder where you have your translated documents to add the document(s) you want to send (just as when adding documents to create a project).
4 –	Click on To TRAdesk and the translated document(s) will be sent to Tradesk.






[bookmark: _Toc499734091]4.7. Sending individual document memories to Euramis (in batch)
If you finished your translation (revision included, if any) using DGT-OT and you want to send it to Euramis:
1 –	In DGT-OT, export the individual memory of the translated document(s) in your project in the format accepted by Euramis by pressing Ctrl+Shit+F8 (or select the Create Euramis Export option from the Tools menu).
2 –	In the DGT-OT Wizard, click on Euramis/Tradesk — Send to send the individual memories so generated to Euramis. 
There is no need to select anything. The Wizard will: 
a) 	Send all the memories in the project \euramis subfolder to Euramis, 
b) 	Move them to the project \euramis\sent subfolder, 
c) 	Make a copy of those memories to the OmegaT_Projects\_PROJECT-MEMORIES in your computer and 
d) 	Make a copy of those memories to the Tradesk \Final folder of each dossier so that you or your colleagues can easily reuse them in future projects.  
You can combine this operation with sending the translated document(s) to Tradesk.

[bookmark: _Toc499734092]4.8. Ranking external memories individually or by subfolders
You can give priority to memories or groups of memories (for instance, Financial Regulation legislation, Horizon 2020 legislation) in an easy way so that:
· In the Fuzzy Matches pane, the matches are displayed (by order of match rate) and, when match rate is identical, by the order of preference you gave to those memories or subfolders. 
· In the Search window, the segments are displayed by the order in which the tmx files were ranked. 

[image: ]

To organise your memories:
1 –	You don’t need to close DGT-OT if you have it open with that particular project.
2 –	In the DGT-OT Wizard, click on Browse and select the \tm subfolder of the active project you want to manage. 
	There you have all the translation memories that were automatically copied to your project by the DGT-OT Wizard when the project was created or updated. 
3 –	Using Windows Explorer, you can rename tmx files (for example 1-22013D0743_EN-PT-AL, 2‑32013R1290_EN-PT-AL) to rank them. 

	Or, even better, you can create subfolders in the \tm subfolder of the project — to where you can copy or drag&drop the tmx files you want to use as reference — and give those subfolders the name and priority you want (in the example above: 1-MAIN-REFERENCES, 2-Norm-Memory).
	You can also just copy/paste folders you have in your computer with thematic translation memories and you can change at any time the priority given to those memories or subfolders without the need to Reload your project.
4 –	You can resume your work if that project was open. If not, click on Open in the DGT-OT Wizard.  
If you are translating a big/complex project and you think there will probably be (many) new versions, you can organise all your memories by subfolders, including the retrievals and all the reference memories.
As the DGT-OT Wizard will, when Updating a project, copy to the \tm main subfolder all the translation memories in \pret in Tradesk — including those that you had already moved to subfolders — this is a practical way for you to know, when you update the project, which are the new memories (by date, for example) and delete the ones that were recopied.
[bookmark: _Toc426467360]
[bookmark: _Toc499734093]4.9. Giving a penalty to memories
Sometimes, it is useful to give priority to reliable translation memories over less reliable ones. 
Machine Translation doesn’t need to have a penalty because it is stored in a separate folder (\mt), and is only displayed in its specific pane and is never mingled with human translations from Euramis.  
To give a penalty to one or more memories, you can create subfolders with names like "penalty-xxx" where xxx is a number from 0 to 100, or use the penalty-50 automatically created by the Wizard in each project.  
A percentage penalty corresponding to the figure in the folder name will be applied to the matches of all translation memory files within such subfolder. For instance, a 100% match will become a 70% match as in the example below (with a penalty of 30%).
	Memory subfolders in the \tm folder
[image: ]
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To do this:
1 –	You don’t need to close DGT-OT if you have it open with that particular project.
2 –	In the DGT-OT Wizard, click on Browse and select the \tm subfolder of the active project. 
3 –	Create a new subfolder with a name indicating the penalty you want (for example: a subfolder named penalty-30) or use the penalty-50 already there. 
4 –	Copy the translation memory file(s) to it. 
5 –	You can resume your work if that project was open. If not, click on Open in the DGT-OT Wizard.  	
[bookmark: _Toc444875210]


[bookmark: _Toc499734094]4.10. Pre-translation 
Pre-Translate only applies to external memories, i.e. memories other than the project memory which contains the segments you translated. 
So, when you Update a project with a new version of an original, there is no need to "pre-translate": your translated segments are all in the project memory and are automatically inserted in the new versions (if they are 100% matches, including tags) without any action on your part. Matches below 100% will be displayed in the Fuzzy Matches pane.
DGT-OT gives you easy and complete control over the reference memory(ies) you want to use for pre‑translation. 
You just have to copy one or more tmx files to the \tm\auto subfolder of your project and the 100% (including tags) segments will auto‑populate your document(s) and be highlighted in an orange background colour to call your attention to the fact that they were automatically transferred to your project memory. 
By default, they will remain so highlighted unless you modify them. If you prefer not to see them highlighted, in the View menu, untick the option Mark Auto-Populated Segments.
You can use pre-translate before starting the translation of a project or at any time in the middle of the process. In the latter case, only untranslated segments in your project memory will be pre-translated. Segments you had already translated in your project will remain untouched.


[bookmark: _Toc444875212][bookmark: _Toc499734095]4.11. Translating with the help of a relay language (tmx2source) 
DGT-OT also allows the use of a (reference) external translation memory with the source language identical to the source language of your project and the target language of the reference memory different from the target language of your project, displaying it in the Editor below the original source segment. 
Example: You have a Lithuanian document to translate into Portuguese and your knowledge of LT is not perfect (or far from it)… but there is already a LT‑EN translation of the same document. In this case you can create a LT‑PT project and use the LT–EN external translation memory to have the EN relay language displayed in the Editor below the LT original segment. 
In this way you can see both the LT and EN as original segments. 
As with this feature only 100% match segments (including tags) will be displayed in the Editor, you can also have the LT-EN memory copied to the \tm subfolder (maybe with a penalty) so that you see the below 100% segments (on account of formatting) in the Fuzzy Matches pane.
You can also use this feature just to display the translation into any other language just for terminology purposes.
If you have a “normal” project and just want to display ongoing translations in other target languages, the process is automated with the View Other Target Languages and you don't need to do it manually (see Section 3.13).

	
\tm subfolder:
[image: ]
\tm\tmx2source subfolder:
[image: ]
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[bookmark: _Toc499734096]4.12. Sharing memories in real time — TeamBase
Using the in-house TeamBase application, you can share memories in real time with other colleagues working on the same (or related) projects and who are using either DGT-OT or Studio. 
A TeamBase memory is a (tmx) memory that is created on a server and which receives a copy of the newly translated or changed segments of all the translators connected to it in Read/Write mode (sending your segments and receiving the segments from all the translators linked to that particular TeamBase memory). In Read mode the translator only receives segments from other translators. 
Take into consideration that only the already translated segments that you reopen and change in DGT-OT will be sent to TeamBase when you have selected the Read/Write mode, i.e., the segments you have translated connected in Read mode and which you afterwards reopen and close — without changing them — in Read/Write mode will not be sent to TeamBase. Pre-translated segments will not be sent to Teambase either.
You can create a TeamBase memory, stay connected all the time or connect and disconnect from it at any time.

[image: ]

To create a new TeamBase memory or to connect to one created by a colleague: 
1 –	In the DGT-OT Wizard, with the project you previously created as the active project (open or not in DGT-OT), click on TeamBase. 
2 –	Accept the default — which is to create a new TeamBase memory with the name of your project — or select a memory from the list displayed in the left column or give a name of your liking.
3 –	Select the mode in which you want to work: Read (receive segments) or Read/Write (receive/send segments). 
4 –	Click on Connect To Shared. That memory will be displayed in the central column. 
5 –	The TeamBase window will close automatically and you can start/continue working on your project.
You should only connect to one Teambase memory in Read/Write mode, but you can connect to any number of other Teambase memories in Read mode. To do that, just follow the same procedure, but selecting Read mode.
To disconnect from any of the TeamBase memories you are connected to, in the Wizard, just click on TeamBase and in the middle column — Shared memories linked to my project — highlight the memory you want to disconnect from and click on Disconnect From Shared.


[bookmark: Section4_12][bookmark: _Toc499734097]4.13. Revision workflow 
The automation of the revision workflow is available in the right side section of the DGT-OT Wizard.
[image: ]
It allows:
a) The translator to easily Send for revision the whole project or just a part of it in the case of multi-document projects.
b) The translator to also Browse the project for revision — after sending it — in order to reorganise folders, for example, by deleting tmx files in the \tm subfolder of the project which will be of no interest to the reviser.
c) The reviser to Get the project for revision and copy it to his/her computer
d) The reviser to Send the revised project back to the translator for finalization (if the translator has the last word) and reorganise it, if necessary, using the Browse button.
e) The translator to Get the revised project to finalize it.
The default, in the Send for Revision window, is to copy the project to a default server location (that you can change in case of SECEM documents) and reorganise the project by copying the project memory (project_save.tmx in the \omegat subfolder) to the tm\auto\draft subfolder of the project for revision so that, when the project is opened by the reviser, the segments translated by the translator (draft) will always be displayed in the Fuzzy Matches pane, even when the reviser changes a segment and later reopens it. 
[image: ]


[bookmark: _Toc499734098]4.13.1. Revision of the whole project
A — The translator, in the DGT-OT Wizard:
1 –	Clicks on Send in the Translator section. 
2 –	Clicks on Send in the Send For Revision window, therefore accepting the defaults.
		The renamed project (for revision and with the translator login) will be copied to the default server location using the project memory (i.e, the memory with all the segments translated in that project, including ‘orphan segments’).
3 –	Clicks on Browse, if he/she wants to reorganise the project to get rid of useless material and make revision easier.
B — The reviser:
1 –	In the DGT-OT Wizard, clicks on Get in the Reviser section
2 –	Chooses the project to be revised by highlighting it in the server default folder displayed and clicks OK
3 –	Opens the project as usual when the copy has been completed by clicking on Open
4 –	In DGT-OT, before starting the revision, clicks on the Rev icon [image: ] (or selects it in Options — Revision Mode) and checks that the Revision Mode is displayed at the top of the DGT-OT window
5 –	When the revision is finished, if s/he has the last word, just finalizes the project in the usual manner
6 –	If the translator has the last word, in the DGT-OT Wizard, clicks on Send in the Reviser section with that project as the active project and the project is, by default, renamed. You can change the name if you want
7 –	Clicks OK and the renamed project (revised and with the reviser login) will be copied to the default server location
8 –	Informs the translator that the project has been revised

C — The translator:
1 –	In the DGT-OT Wizard, clicks on Get in the Translator section and selects from the Projects-Revised list displayed the revised project.
2 –	Clicks on Open to open the project in DGT-OT.
3 –	In DGT-OT, to quickly see the segments that have been changed by the reviser in order to accept them or not, in the View menu, ticks Marks Revised and Changed Segments and those segments will be highlighted in red in the Editor. 
		To quickly open and check those segments, use the shortcuts Ctrl+Shift+X or Ctrl+Shift+Y (or select it in the Go To menu: Next Revised & Changed Segment and Previous Revised & Changed Segment).
4 –	In the Fuzzy Matches pane is displayed — from the \tm\auto\draft — the translation made by the translator so that s/he can compare it (with track changes in target) with the changes made by the reviser shown in the Editor.
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		The translator can either accept all the changes or recapture the whole segment s/he had translated from the Fuzzy Matches pane (Ctrl+R), but it cannot accept some changes and discard others. If that is the case, the translator must choose one of the two and make the partial changes manually.
		On the bright side, the translator can easily see, in the Editor, the “clean” segment as changed by the reviser and, in the Fuzzy Matches pane, his/her non-revised translation with track-changes. This may be useful if the reviser made many changes in a long segment!
5 –	Finalizes the project as usual.

[bookmark: _Toc499734099]4.13.2. Revision of part of a project
The translator may not want to send the whole project memory, either because:
a) In a multi-document project, only part of the documents are ready for revision; or 
b) When there are many versions of one or more documents, there may be many ‘orphan’ segments (i.e., segments that were translated in previous versions but which no longer exist in the final document sent for revision and therefore were not carefully checked by the translator).
In that case, the workflow is the same as in the previous section, with the exception that the translator must:
1 –	In DGT-OT, Create OmegaT Export (by clicking on Ctrl+Shift+F9 or selecting it in the Tools menu) of the document(s) to be sent for revision; and
2 –	In the DGT-OT Wizard, in the Send for Revision window, click on the 3rd field to choose to create the Project for Revision only with the segments from the desired documents
[image: ]

The renamed project (for revision and with the translator's login) will be copied to the default server location using the exports generated for each document and which contain all the information (formatting and notes included) only for the selected documents in their final version.
[bookmark: _Toc426467296][bookmark: _Toc444875178]



[bookmark: Section6][bookmark: _Toc499734100]5. DGT-OT MAIN FUNCTIONS, SHORTCUTS AND ICONS
Functions and shortcuts: As in most applications, you can use the menus (with the full features) or the shortcuts (for many operations). Below are listed some of the most frequently used. 
DGT icons: DGT IT Unit has added some icons for the most common operations, which are self-explanatory (place the cursor over them and a descriptive text will appear). 
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[bookmark: Icon2][bookmark: Icon5][bookmark: Icon7][bookmark: Icon8][bookmark: Icon9][bookmark: Icon10][bookmark: Icon11][bookmark: Icon12][bookmark: Icon14][bookmark: Icon15][bookmark: Icon16][bookmark: Icon17]    1      2     3     4     5     6       7     8      9    10    11    12   13  14   15    16    17    18    19   20    21     22      23  
	Function
	Icon
	Shortcut
	Information

	New project
	1
	
	A new project is usually created via the DGT-OT Wizard

	Open project
	2
	Ctrl+O
	Projects are usually opened via the DGT-OT Wizard

	Reload
	3
	F5
	If you add or delete documents, or if you change your preferences, in an DGT-OT project

	Close project
	4
	Ctrl+Shift+W
	To close the project, but not DGT-OT.

	Undo last action
	5
	Ctrl+Z
	To undo the last action, but only in the segment open in the Editor
DGT-OT has no Undo last action for overall operations like Replace.

	Redo last action
	6
	Ctrl+Y
	To redo the last action, but only in the open segment in the Editor

	Search project
	7
	Ctrl+F
	To search terms/strings — with many options — in the whole project and in the external memories, glossaries and notes.

	Search and Replace
	8
	Ctrl+K
	To Search/replace — all or one by one — in the whole project.

	Go to previous segment
	9
	Ctrl+P
	To close and save the segment to the project memory and to open the previous (translated or untranslated) segment for editing.

	Got to next segment
	10
	Ctrl+N
	To close and save the segment to the project memory and to open the next (translated or untranslated) segment for editing. Same as Return.

	Go to next untranslated segment
	11
	Ctrl+U
	To close and save the segment to the project memory and to open the next untranslated segment (in Translation Mode) or the next unrevised segment (in Revision Mode) for editing.

	Go to the next  translated segment
	
	Ctrl+Shift+U
	To close and save the segment to the project memory and to open the next translated segment for editing.

	Go to next unique segment
	
	Ctrl+Shift+H
	Allows to "bypass" non-unique segments already translated and auto-propagated.

	Replace with match
	12
	Ctrl+R
	To replace the target segment with the match selected (in bold) in the Fuzzy Matches pane.

	Insert match
	13
	Ctrl+I
	To insert in the target segment, at the position of the cursor, the match selected (in bold) in the Fuzzy Matches pane.

	Replace with Machine Translation
	14
	Ctrl+M
	To copy machine translation output that is displayed in the MT pane to the target segment or to replace what is there.

	Insert Next Missing Tag
	
	Ctrl+T
	To insert (the first or) the next missing source tag in the target segment at the position of the cursor.

	Insert missing source tags
	15
	Ctrl+Shift+T
	To insert all the missing source tags in the target segment at the position of the cursor.

	Validate tags
	16
	Ctrl+Shift+V
	To show the list of segments with missing/different/surplus tags in the target segment. Clicking on the segment number, DGT-OT jumps to that segment in the Editor for editing.

	Revision Mode
	17
	
	By default DGT-OT opens always in Translation Mode. If you are revising a document (either because you are the reviser or because, as a translator, you want to mark segments you revise as such), click on this icon or select Revision Mode in the Options menu.

	DocFinder
	18
	Ctrl+Shift+D
	Highlight the reference to search and it opens DocFinder.

	Quest
	19
	Ctrl+Shift+Q
	Highlight the term/string to search and it opens Quest

	IATE
	20
	Ctrl+Shift+L
	To open IATE full‑fledged interface with all search options and allowing the creation of new IATE entries.

	Euramis
	21
	Ctrl+Shift+E
	Highlight the term/string to search and it opens Euramis full‑fledged interface with more search options.

	View Other Target Languages
	22
	
	To view the translation into other languages of ongoing projects. Options: view as another source segment in the Editor, view in the Fuzzy Matches pane with a penalty and view as a bilingual HTLM file.

	Quit
	23
	Ctrl+Shift+Q
	To quit the project and DGT-OT

	Project files
	
	Ctrl+L
	To display the list of documents in the project

	Create Translated documents
	
	Ctrl+D
	To create all the translated documents in their native applications. DGT-OT stores them in the project \target subfolder

	Create Current Translated Document
	
	Ctrl+Shift+D
	To create the translated document displayed in the Editor in its native application. DGT-OT stores it in the project \target subfolder

	Open project Folder
	
	Ctrl+Shift+F1
	To open and navigate the project folder in Windows Explorer

	Insert glossary entry
	
	Ctrl+Shift+G
	To create a new glossary entry 

	Open writable glossary
	
	Ctrl+Shift+F2
	To open the glossary in a text editor (Notepad++ or any other) to change or delete entries.

	Go To Next/Previous Revised & Changed Segment
	
	Ctrl+Shift+X
Ctrl+Shift+Y
	Used in the revision process for the translator to check the changes made by the reviser displaying — in the Fuzzy Matches pane — the tracked changes in the target segment.

	Spellchecker
	
	Ctrl+Shift+F7
	To detect spelling mistakes/unknown words in the whole project and to add learned/ignored words for that target language for all projects.

	Quality check
	
	Ctrl+Shift+F3
	To carry out several levels of quality checking in the whole project

	Auto-completion
	
	Ctrl+space
	To display and insert Glossary Entries, Auto-Text Entries, Missing Tags and characters/symbols from the Character Table

	Auto-completion — cycle
	
	Ctrl+Page ↑↓
	To cycle between Glossary Entries, Auto-Text Entries, Missing Tags, Character Table



Besides the editing functions in DGT-OT, you can also edit your segments using the general shortcuts below. These only apply to the segment open for editing in the Editor pane.

	Function
	Shortcut
	Information

	Select all
	Ctrl+A
	Selects all the text in the open segment and highlights it in blue

	Copy text
	Ctrl+C
	Copies the selected text to be afterwards pasted into another segment (as DGT-OT “remembers” it even after the segment is closed) or into another application

	Paste text
	Ctrl+V
	Pastes the copied text into the open segment in the Editor or into another application.

	Delete text
	Ctrl+X
	Copies the highlighted words in the segment open in the Editor and deletes them. Copied text is available as in "Copy Text".
Take into consideration that the highlighted text is also deleted from the project memory when you validate that segment, i.e., when you open that segment again you will not get back your previous translation.



[bookmark: Section7][bookmark: _Toc426467383]
[bookmark: _Toc499734101]6. LIST OF MEMORIZED REGULAR EXPRESSIONS

These regular expressions are memorized in the Search window for the In Source field. They will be displayed when the Expression mode is set to Regular Expressions and the Regular Expression Mode is set to Partial Segment.
As the Memorize feature is field-dependent, copy the regular expressions you need to other fields in the Search window or in the Search/Replace or Search and Translate windows. 
	Regular expression
	Memorized description
	What it finds

	[\d]{1,},[\d]{1,2}
	1-2DECIMALScomma
	Decimal numbers  (2 decimal places) separated by comma (,)

	[\d]{1,}\.[\d]{1,2}
	1-2DECIMALSdot
	Decimal numbers (2 decimal places) separated by dot (.)

	[\d]{1,}\.[\d]{1,2}%
	1-2DECIMALSdotPERCENTAGE
	Decimal numbers (2 decimal places) separated by dot (.) immediately followed by %

	[\d]{1,2}[\.-\/][\d]{1,2}[\.-\/][\d]{4}
	DATES
	Dates in following formats: (D)D.MM.YYYY, (D)D-MM-YYYY and (D)D/MM/YYYY
At the beginning of segment :  add ^ at the beginning, e.g. ^[\d]{1,2}[\.-\/][\d]{1,2}[\.-\/][\d]{4}
At the end of segment :  add $ at the end, e.g. [\d]{1,2}[\.-\/][\d]{1,2}[\.-\/][\d]{4}$

	[\d]+
	DIGITSall
	Any number of digits
W/ NOT ticked: only segments without digits
W/ "Full segment" activated: segments with digits only (i.e. no spaces, punctuation, symbols or letters)
W/ "Partial segment" activated: segments which possess at least one digit

	[\d]{1,}%
	DIGITSpercentages
	Digit(s) immediately followed by %, e.g. 5%
With a space before %: [\d]{1,}\s% (\s caters for all kinds of spaces and tab)

	[A-Za-z]+
	LETTERSall
	Any number of upper- and lowercase letters (i.e. no spaces, digits punctuation, symbols or letters from other alphabets)
W/ NOT ticked: only segments without any letters
W/ "Full segment" activated: segments with letters only (i.e. no spaces, punctuation, symbols or letters from other alphabets)
W/ "Partial segment" activated: segments which possess at least one letter

	^\([a-zA-Z]{1,4}\)
	LETTERSstartBRACKETS
	Segment starting with characters (case-insensitive) in brackets, e.g. (a), (i), (vi) or (VI)

	^[^a-zA-Z]+$
	NoLETTERS
	Segments WITHOUT alphabetic characters (e.g. numbers, dots, commas, spaces, dashes)

	\([\d]+\)
	NUMBERSbrackets
	Numbers in brackets with no spaces

	[\d\.\s,<>t\/]+
	NUMBERSdotCOMMAtagSPACE
	Numbers including dots, OmegaT tags, commas, spaces in any combination.
W/ "Full segment" activated: segments consisting only of numbers and/or dots and/or OmegaT tags and/or commas and/or spaces in any combination
W/ "Partial segment" activated: not suited

	[\d]{1,}-
	NUMBERShyphen
	Numbers followed by a hyphen

	[\d]{1,}\s[\d]{3}
	NUMBERSseparSPACE
	Numbers with a space between groups of digits, e.g. (10 000)

	\([\d]{1,}\s[\d]{3}\)
	NUMBERSseparSPACEbrackets
	Numbers in brackets with a space between groups of digits, e.g. (10 000)

	\s\s+
	SPACEdouble
	Segments with double space

	\b[A-Za-z]+\b $
	WORDend
	Segment ends with word
W/ NOT ticked: Segment does NOT end with a word

	(\b\w+\b)\s\1\b.
	WORDSrepeated
	Segments with repeated words

	^\b[A-Za-z]+\b
	WORDstart
	Segment starts with word
W/ NOT ticked: Segment does NOT start with a word


 


[bookmark: _Toc422823067][bookmark: _Toc426467384][bookmark: _Toc467168432]
[bookmark: Section8][bookmark: _Toc499734102]7. TROUBLESHOOTING
DGT-OT and its Wizard are usually quite reliable… but of course issues can happen as with any other application.
Here is a list of problems I already had to deal with. And the ways to fix them… hopefully.
If you face an issue you cannot solve, well… call for help!

	
PROBLEM

	
MAYBE
	
TROUBLESHOOTING

	The project has been created in the DGT-OT Wizard but DGT-OT displays an error message and does not open the project
	It is a problem with TagWipe
	Create the project again in the DGT-OT Wizard with TagWipe unticked.
If it is OK, work with Remove Tags activated… or ask for Help.

	You created a new project and have no matches from Euramis (nor suggestions from Machine Translation
	Maybe you forgot to define the correct language combination
	If that is the problem, delete the project and create it again with the correct language combination or create it with a different name. 

	You created a project (with the correct source and target languages) and Machine Translation output is not displayed
	The MT file was not generated because the language pair is not processed automatically or it is a multilingual project or MT@EC failed to handle the original file.
	Request MT from the MT@EC service directly (https://mtatec.ec.testa.eu/mtatec/translateDocument.html).

	The project — which had been working normally in previous sessions — does not open
	It is a problem with the omegat.project file that disappeared or is corrupted.
	Check if that file is in the main folder of your project and that it is not empty. In both cases, with the project closed in DGT-OT, copy the omegat.project file from any other project with the same language combination you already have and open the project again. Hopefully it will work!

	Target documents not created
	You have one or more translated documents open in their native applications
	Check that there are no documents open and Create the Translated Documents again

	You sent a project for revision or a revised project using the Wizard and the project is not available to the translator/reviser
	The U: drive was not connected when you used this feature
OR
You have not closed DGT-OT.
	Check it, if not connected, connect it, and try again.


	You are using shared glossaries and DGT-OT opens the Project\Properties menu and the paths to the shared glossaries are marked in red
	There is a connection problem with the server driver (e.g. U: drive)
	Run MapMyDrives from Windows Start menu, close DGT-OT and once all drivers are reconnected reopen DGT-OT. If the problem persists, redirect the glossary paths to your local project.





	

PROBLEM

	

MAYBE
	

TROUBLESHOOTING

	Spellcheker is not working for your particular target language
	You forgot to define the correct target language before creating the project
OR
The dictionaries are not correctly defined.

	In the DGT-OT Wizard, check that you have the correct target language for that project.
OR
In DGT-OT, check that the dictionaries are correctly defined: In the Options — Spell Checking menu, just copy/paste to the field Dictionary File Folder the following path — C:\PGM\DGTapps\CAT2016\OmegaT\SPELLERS\Both,${user.home}\AppData\Local\DGT\OmegaT_Projects\_CONFIG-PERSONAL — replacing what is there.
You should see the list of the dictionaries for all EU languages.

	You deleted one or more files from the project by mistake and want to get them back
	As there is no Undo feature for this operation…
	You can retrieve them from the H: drive where a copy of your project is kept or Restore it from the Recycle Bin

	You made a BIG mistake with Replace All and you want to do UNDO
	As there is no Undo feature for this operation…
	You can use a backup of the project memory in the \omegat folder.
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Estes critérios destinam-se a promover produtos que tenham um impacto reduzido nos ecossistemas aquaticos, que
contenham uma quantidade limitada de substéancias perigosas, séo eficazes e minimizem a producéo de residuos mediante
a redugdo das embalagens.

Editor -ENV-2016-80083-00-01PT-TRA-00.00CK.

group.

Translation last modified by machame on 16/nov/2016 at 19:58:08

The revised criteria, as well as the related assessment and verification requirements, should be valid for six
years from the date of notification of this Decision, taking into account the innovation cycle for that product group.
Os critérios revistos, bem como os correspondentes requisitos de avaliagéo e verificagéo, devem ser validos durante seis
anos a contar da data da notificagéo da presente deciséo, tendo em conta o ciclo de inovacéo deste grupo de produtos.

Those criteria aim at promoting products that have a reduced impact on aquatic ecosystems, contain a ed
amount of hazardous substances, are effective, and waste production by reducing packaging.
<segment 0507 +2 moreMatch 65/63/68%>

<end segment>

Translation last modified by machame on 18/nov/2016 at 12:21:40
For reasons of legal certainty, Decision 2011/383/EU should be repealed.
Por razdes de seguranca juridica a Decisdo 2011/383/EU deve ser revogada.

A transitional period should be allowed for producers whose products have been awarded the EU Ecolabel for all-
purpose cleaners and sanitary cleaners on the basis of the criteria set out in Decision 2011/383/EU, so that they
have sufficient time to adapt their products to comply with the revised criteria and requirements.

The measures provided for in this Decision are in accordance with the opinion of the Committee established by

2-MAIN-LEGISLATION\NoDG-2011-32011D0264_EN-PT-DWN.tmx (+3 more) 23-06-
2011 3:10

Match: <63/68%> - Source: <-2011-32011D0264> - Translator: <>

1) S: TheThose criteria aim,-in-particular; at promoting products that have a
reduced impact on aquatic ecosystems, contain a limited amount of hazardous
'substances, are effective, and whose performance has been-testedm i
waste production by reducing packaging.

T: Os presentes critérios destinam-se, em especial, a promover produtos
que tenham um impacto reduzido nos ecossistemas aquaticos, que contenham
uma quantidade limitada de substancias perigosas e cujo desempenho tenha
sido submetido a ensait

2-MAIN-LEGISLATION\NoDG-2012-32012D0721_EN-PT-DWN.tmx (+7 more) 01-12-
2012 16:04

Glossary
2. mira B
aiming = pontaria
aquatic ecosystem
1. ecossistema aquatico
2. idro-ecossistema
aquatic production = producéo de aquicultura

Notes

Mutple Transiatons

Comments | Dictionary
[prfect autosaved on 1220
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UNCTAD "World Investment Report 2017
UNCTAD: «World Investment Report 2017: Investment and the Digital Economy»

Translation last modified by borrehe on 17/set/2017 at 15:46:51
Last revised by: borrehe, 17/set/2017 16:46:51

Investment and the Digital Economy"

FR: Investment and the Digitel Economy.

<segment 0181 ** ALREADY TRANSLATED ** >

(GNUGED: Relatorio sobre o investimento mundial de 2017 Investimento e economia digital)
<end segment>

Transilation last modified by machame on 12/set/2017 at 20:31:27
Last revised by: borrehe, 17/set/2017 16:46:54
Idem.

o

Digital/DigitalDigtal
1.0DD
2. Digital/Digital/Digtal

digital
1. digtal
2. numérico

digital economy = economia digital

Notes | Mutple Transiations

helena - esta traduzido em PT?

estala  AND the Digital Economy.

Dictonary
Project autosaved on 0:09
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Last modified by unknown
In addition, energy efficiency helps reduce imports of fossil fuels which boosts the EU's trade balance, and also improves the energy security of
Member States that are exposed to a highly concentrated supply source for gas.

Last modified by unknown

‘objectif contraignant de 30 % en matiére defficacité énergétique proposé par la Commission améliorera la sécurité énergétique en réduisant les
importations de combustibles fossiles de 12 % en 2030, ce qui représente 70 miliards d'EUR d'économies sur les importations.
<segment 0255 ** SOURCE TRANSLATION ** >

Edtor -ENER-2017-80077-03-00-00-7T-TRA-00.00CK s _ O | [ achine Transiaton =
| elevados de eficiéncia estéo associados a impactos macroecondmicos que s30 positivos tanto em termos de PIB como de emprego *| [0 objetivo vincuiativo de eficiéncia
energética de 30 % proposta pela

Comisséo melhorara a seguranca
energética mediante a reducéo das
importagdes de combustiveis fosseis de
12 % em 2030, 0 que corresponde a uma

poupanca nas importagdes de 70 mil

milhges de euros.

Gossary -0

Commission @
1. Comisséo

2. Comissio Europeia

redugéo de 12 % nas importagdes de combustiveis fésseis em 2030, o que corresponde a economias nas importagdes de 70 mil milhdes de EUR.

<end segment> 3. Comissao da Unido Africana
L e ! -

Fuzzy Matches 7 0 || Metes | it Tronsations
0-DRAFT\project_save.tmx (+1 more) 20-11-2017 17:01 -
Match: <1001100%> - Source: <--> - Translator: <>
1) §: The binding 30% energy efficiency target proposed by the Commission will improve energy security by reducing fossil fuel imports by 12%
in 2030 which corresponds to import savings of EUR 70 billion. Comments =

T: O objetive vinculativo de 30 % de eficiéncia energética proposto pela Comissio melhorara a seguranga energética ao permitir uma » 3

ey:

3bcad255-20bc-42cb-8a52-0a81a74554z .
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Translation last modified by machame on 16/nov/2016 at 19:54:05

Having regard to the Treaty on the Functioning of the European Union,
<segment 0006 +5 more **TRA™ >

h’endo em conta o Tratado sobre o Funcionamento da Unido Europeia,
<end segment>
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Translation last modified by machame on 16/nov/2016 at 19:54:02
Last revised by: borrehe, 16/nov/2016 20:42:37
establishing the EU Ecolabel criteria for dishwasher detergents

<segment 0003 “TRA™ >
que estabelece os critérios do rétulo ecolégico da UE relativos a detergentes para maquinas de lavar louca

<end segment>
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